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1.0 Introduction 

The Comprehensive Environmental Response, Compensation, and Liability Act of 1980 

(CERCLA), as amended, and the Oil Pollution Act (OPA) provide for the restoration of natural 

resources lost or injured by hazardous substance releases (§107(f)) and discharges of oil (§1006) 

and require the designation of certain Federal and State officials to act on behalf of the public as 

Trustees for natural resources. The Missouri Department of Natural Resources together with the 

U.S. Fish and Wildlife Service and the U.S. Forest Service, acting as Trustees, are conducting a 

Natural Resource Damage Assessment (NRDA) in the Southeast Missouri Lead Mining District, 

in both the Old Lead Belt and the Viburnum Trend. The purpose of conducting a NRDA is to 

identify and document the extent of injuries to natural resources, quantify the injuries and all 

associated losses to the public and select restoration projects.  

 

2.0       Site Information 

2.1 Location 

The work in the Southeast Missouri Lead Mining District (SEMOLMD) will take place in the 

Old Lead Belt (OLB), which is approximately 60 miles southwest of St. Louis, and in the 

Viburnum Trend area (VTLMD), also known as the New Lead Belt. The SEMOLMD lies in the 

geologic formation known as the Ozark Dome (see Figure 1). Table 1 lists the sampling 

locations. 

 

2.2  Description 
 
The SEMOLMD has been mined for over one hundred years and has the largest source of lead 

ore in the United States.  Mining in SEMOLMD is conducted by the Doe Run Company, the 

largest producer of lead (Pb) in the nation (Wikipedia, 2012).  Topography in the New Lead Belt 

is characterized by rolling hills dissected by narrow floodplain, creek, and river valleys.  Hills 
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and ridges are generally steep sided with flat tops consisting of thin mantles of clayey soils. The 

major physical features of the area are the St. Francois Mountains in the east, and the dissected 

topography of the Salem Plateau in the northern and central portions. The principal drainage 

systems for the VTLMD are the north flowing Courtois and Huzzah Creeks and their tributaries 

and the east and south flowing Black River and its tributaries.  The principal drainage systems 

for the OLB are Flat River Creek, Big River and its tributaries. 

 

Mining in the OLB ceased in 1972 with the closing of the Federal Mine (aka St. Joe State Park). 

Mining in the VTLMD is ongoing, and the district remains a major producer of metals: 

Missouri’s mines have yielded much of the United States’ national production of lead, and since 

1997, all the lead produced in Missouri originated in The Doe Run Company’s Viburnum Trend  

 

 

Name Northing Easting Comment

Contaminated 

Sites 

Washington State Park 4217979.013 703235.487 WSP beach on road

St. Joe State Park 4190827.036 718728.298 MO mines by RR tracks

Magmont Vent 4169315.283 665724.666 VT Magmont vent

KK & 32 4168066.692 663013.162 

VT  County  Road  KK  & 

Highway 32 

West of Buick Smelter 4166274.207 664633.762 VT west of Buick Smelter

Reference Sites 
Mill Creek Recreational Area 4192153.194 594477.035   

Council Bluff Lake 0.000 0.000 no point collected

DNR State Parks 

USForest Service 

 

Table 1.  General Locations for Trapping Grids. 
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Figure 1. Cambrian and Pre-Cambrian Geologic Uplift Forming the Ozark Dome 
 
Missouri DNR, 2009
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Figure 2. The Viburnum Trend Lead Mining District 
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Figure 3. Old Lead Belt 
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Figure 4: Proposed Small Mammal Sampling Locations 
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mines.  In addition to lead, the mines produce substantial amounts of zinc and lesser quantities of 

copper and silver (Seeger 2008).   

 

Mining operations within the VTLMD  

 

Mining in the Viburnum Trend has consisted entirely of the room and pillar method along the ore 

trend (Seeger 2008). Ore is first crushed within the mine, and then removed to the surface for 

beneficiation, including further crushing. Following the crushing, the slurried fine material is 

sent to flotation cells and separated into mineral concentrates through circuits specific to each 

metal (lead and zinc at all mills, copper as well at all except Sweetwater and West Fork). The 

mineral concentrates are settled and dewatered before further action (either transport to the 

smelter or to a buyer). The resultant waste is collected in tailings ponds along with all process 

water. Unlike earlier operations in the SEMOLMD, the Viburnum Trend operations never used 

density separation methods, which result in chat piles (Seeger 2008). 

 

There are seven major tailings impoundments (tailings are mill waste produced by separating ore 

from host rock), ten mines, and a secondary Pb smelter in the Viburnum Trend within the Black 

River and Meramec River watersheds. 

 

Mining operations within the OLB 

 

Mining in St. Francois County (aka the Old Lead Belt) was first recorded between 1742 and 

1762. The introduction of the diamond drill in 1869 helped to facilitate the discovery of 

additional reserves and in turn increased lead production from the mines dramatically in the late 

1800s. Mining was at its peak in the OLB in 1942 when 197,430 tons of lead was produced. 

With the closing of the Federal Mine in 1972, mining in the county ceased. There are eight mine 

waste areas within the OLB (either chat or tailings): Bonne Terre, Desloge, Doe Run, 

Elvins/Riversmines, Federal/St. Joe State Park, Hayden Creek, Leadwood, and National. 
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2.3  History/Contaminants of Concern 

Releases of heavy metals from the tailings impoundments, mines, and smelter in the SEMOLMD 

have been documented.  Elevated levels of cadmium, copper, lead, nickel, and zinc have been 

measured in surface and shallow subsurface soil at facilities in the VT and OLB.  Considering 

the concentrations measured relative to common screening benchmarks, it is clear that the 

primary contaminant of concern for the site will be lead.  The Missouri Trustees for Natural 

Resource Damage Assessment and Restoration (Trustees) believe that there may be potential 

injuries to natural resources in Reynolds, Iron, and St. Francois Counties, Missouri resulting 

from releases of hazardous substances from the SEMOLMD.  Consequently, the Trustees have 

designed a plan to study the extent of damages on small mammals from the potential release of 

heavy metals from mining facilities.  

 

3.0 Data Quality Objectives 

To help ensure precise, accurate, representative, complete, and comparable data, all field work 

and analyses will be conducted in accordance with the Quality Assurance Project Plan (QAPP) 

for Natural Resource Damages, Revision 3, April, 2011 (MDNR, 2011).  The QAPP describes 

the general data quality objectives (DQOs), lab and field duplicates, matrix spikes and standards, 

chain-of-custody procedures and other specifications for site assessment investigations 

conducted by MDNR.  Those DQOs specific to this project are described below.   

3.1 Problem Statement 

Levels of lead exceeding 1,000 mg/kg have been measured in surface soil at various facilities 

and locations within the SEMOLMD.  These levels far exceed most ecological screening 

benchmarks for lead in soils which are in the range of 120-400 mg/kg. Beyer et al (2013) found 

that soil lead levels of 1,000-3,200 mg Pb/kg in the SEMOLMD would likely be toxic to 

songbirds. Therefore, there is concern that lead released from the tailings impoundments, haul 

roads, and wind transfer have resulted in injuries to terrestrial natural resources (small mammals) 

in the SEMOLMD area. MDNR has chosen to look specifically for mice (Peromyscus species) 
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and shrews (Sorex, Blarina, and Cryptotis species) due to the nature of their habitat and eating 

habits. The shrew is of particular importance because of its primarily insectivorous diet 

(earthworms). 

3.2 Planning Team 

The planning team includes staff from the DNR Hazardous Waste Program (HWP), DNR 

Environmental Services Program (ESP), United States Geological Survey (USGS) Patuxent 

Wildlife Research Center, University of Missouri School of Veterinary Medicine (UM-SVM),  

Kirksville College of Osteopathic Medicine (KCOM), and the Missouri Department of Health 

and Senior Services (MDHSS). 

 

3.3 Field/Analytical Team 

Staff from HWP and ESP will be in the field baiting/setting/checking traps and transporting 

small mammals caught within these traps. Staff from USGS, UM-SVM, and KCOM will be on 

hand to assist with the anesthesia, exsanguination, blood collection, tissue dissection and 

collection, and general handling of the animals.  

3.4 Conceptual Site Model 

Mining-related metals can be released from the tailings impoundments and other mining/milling 

activities in a number of ways.  The primary transport mechanism for metals to the terrestrial 

environment surrounding the tailings impoundments is assumed to be via wind and surface 

runoff.  Therefore a higher soil concentrations and a further extent of influence is expected in the 

predominant downwind and downhill directions at each impoundments or tailings/chat pile.  

Landscape features, surface water runoff, soil type and vegetative cover will also affect the 

deposition and fate of mine waste released from the tailings impoundments and smelters.  The 

trapping will be conducted at areas which have already been tested for soil lead and have values 

>1000 mg/kg (on average) (Beyer 2013). 
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Activity Person(s) Involved Associated  Agency On Site 

(Y/N) 

1. Animal Trapping 

and Transport 

 

2. Earthworm 

Collection 

Kathy Rangen, Hillary Wakefield, 

Johns Nichols, Eric Gramlich 

(MDNR/HWP); Ken Hannon, 

Sean Counihan (ESP); Nelson 

Beyer (USGS); Dave Mosby, 

Scott Hamilton, John Weber 

(USFWS) 

MDNR/ HWP, 

USFWS, USGS and 

ESP 

Y (all) 

Animal Anesthesia Stan Casteel (UM-SVM) UM-SVM Y 

Animal Blood Draw Stan Casteel, Orin Mock (KCOM) UM-SVM, USGS, 

and KCOM, 

Y 

Animal Necropsies 

and tissue collection 

Stan Casteel UM-SVM Y 

Blood Sample Prep Stan Casteel UM-SVM Y 

Femur Prep Stan Casteel UM-SVM Y 

Field Hematocrit Stan Casteel UM-SVM Y 

ALAD analysis Barnett Rattner (USGS) 

 

USGS N 

Blood Lead/ Tissue 

Metals 

Lab Technician MDHSS N 

Blood Histopathology Lab Technician UW-Madison N 

Organ Histopathology Lab Technician UM-SVM N 

Femur Analysis Lab Technician MDHSS N 

Oxidative Stress/DNA 

damage assay 

Natalie Karouna (USGS) USGS N 

Table 2. Field/Lab Activities and Roles of the Agencies 
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3.5 Study Questions 

As a result of the mining and smelting that has gone on in the study area for the last 100 years, 

the land has become contaminated with hazardous substances related to mining. Lead is the 

contaminant that is most likely to be toxic to small mammals such as shrews, voles, and mice; 

although zinc, cadmium and other metals associated with the ores are possibly toxic.  The 

principle study questions are: 

 

1. Determination the degree of blood ALAD (delta-aminolevulinate dehydratase) inhibition 

found in all small mammals captured.  

2. What is the average concentration of Pb, Zn and Cd in the blood, kidneys and livers 

found in all small mammal species captured? What is the average concentration found 

within each species captured? 

3. What is the average concentration of lead found in the femurs of each species captured? 

4. What are the concentrations of Pb, Fe, Cu, Ni, Zn, Cd and Al in undepurated earthworms 

and soil samples associated with the reference and study sites? 

5. What histopathologic manifestations of heavy metal exposure are identified in kidney, 

spleen or liver tissues? 

6. Determine the relationships between soil Pb, earthworm Pb, blood Pb, liver Pb, kidney 

Pb, ALAD inhibition and tissue pathology.     

3.6 Inputs to Study Questions 

The following lists the inputs required to address the principal study questions: 

 Results of ALAD/blood tests will be used to determine if lead has caused a reduction in 

enzyme activity. 

 The lead concentrations found in the organs of the mammals will be compared with 

toxicity values from other studies. Metrics will be used to determine if there is a positive 

correlation between lead values in the soil and/or earthworms and the level of lead found 

in the animals. 
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 The lead levels in the femurs of the animals will increase with greater exposure and 

increased age of the animal. 

 Histopathology of organs (lesions, cysts, etcetera).  

 Soil metals concentrations 

 Earthworm metals concentrations 

3.7 Study Boundary 

The study will take place primarily in the VTLMD and in the OLB. The reference sites will be 

located at the Mill Creek Recreational Area, Council Bluff Lake, and/or Cedar Creek 

Recreational Area. The sampling locations will be located at Washington State Park, St. Joe 

State Park, and in the Viburnum Trend at three sub-sites: the Magmont Vent Pipe Site, at 

Highway 32 and State Route KK, and West of Buick Smelter. See Figure 4 for a map of the 

study locations. 

 

Small mammal trapping will take place in 2014 over the course of two to three potentially non-

consecutive weeks in May. 

 

3.8 Tolerable Limits on Decision Error 

The hypothesis is that the high lead levels in the soil will be ingested by soil dwelling  

invertebrates, such as earthworms, and be taken up by certain plants. Small mammals that feed 

on these invertebrates and plants will uptake lead directly through ingestion of food or 

incidentally by eating food with soil particles attached. 

3.9 Sampling Design 

A combination of Sherman live traps, Longworth live traps and pitfall traps will be used to 

collect the small mammals in a sampling grid of 150 meters by 150 meters. Traps are to be 

placed 10 meters apart. A trial run will be scheduled to determine the ease of which the pitfall 

traps can be installed, since much of the Viburnum area is glade.  The numbers of traps used will 

depend on preliminary sampling - possible numbers are 25 pitfall traps, 100 Sherman live traps 
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and 100 Longworth traps per site. Earthworms and soil samples will also be collected at the time 

of trapping. 

 

3.10 Sampling Time Frame  

A sample test run will take place one week in April, 2014. The purpose of this test run is to be 

certain that our trapping, processing and analytical methods are effective and that we can capture 

and process the necessary number of small mammals needed for a robust study outcome. 

 

The actual timeframe for the study is currently scheduled for May 2014. The capture rate of 

mammals may be higher in the spring as opposed to autumn sampling. Also, the logistics 

determined from the test run will help to determine if we are fully prepared to do a full blown 

study this spring or if more preparation time is needed to obtain the best possible data. 

 

 

A  B  C  D  E  F  G  H  I  J  K  L  M  N  O 

1  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  1 

2  L  P  L  L  P  L  L  P  L  L  P  L  L  P  L  2 

3  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  3 

4  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  4 

5  L  P  L  L  P  L  L  P  L  L  P  L  L  P  L  5 

6  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  6 

7  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  7 

8  L  P  L  L  P  L  L  P  L  L  P  L  L  P  L  8 

9  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  9 

10  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  10 

11  L  P  L  L  P  L  L  P  L  L  P  L  L  P  L  11 

12  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  12 

13  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  13 

14  L  P  L  L  P  L  L  P  L  L  P  L  L  P  L  14 

15  S  L  S  S  L  S  S  L  S  S  L  S  S  L  S  15 

A  B  C  D  E  F  G  H  I  J  K  L  M  N  O 

Figure 5. Sampling Grid (P=Pitfall, S=Sherman, L=Longworth) 

DRAFT



SEMOLMD Small Mammal Sampling and Analysis Plan 

Page 14 

 

 

 

4.0  Small Mammal Collection 

Sampling will be conducted in two teams of two personnel to bait, set, and check the traps.  Staff 

from the UM-SVM will be present to process the animals. Processing of the animals will include 

drawing blood, euthanizing the animals, and removing the organs to be analyzed. The blood will 

be placed on ice and transported to the MDHSS lab for lead analysis. Animal tissues and bone 

will be placed on ice and transported to UM-SVM for femur lead analysis and tissue pathology. 

Blood samples for the ALAD analysis will be frozen with liquid nitrogen and placed on dry ice 

to be delivered to USGS Patuxent Wildlife Research Center. 

4.1 Sampling Methods 

4.1.1 Mammal Trapping 

All traps will be provided with Dacron bedding to prevent hypothermia in trapped animals 

overnight. The bait used in the traps will likely consist of a peanut butter and rolled oats 

combination along with freeze-dried mealworms to ensure the a variety of small mammals will 

be caught. The pitfall traps will also have Dacron bedding placed in them but will have live 

mealworms as bait, since we are primarily looking for shrews with this type of trap. All types of 

traps will also be provided with a source of hydration such as a gelatin cube. 

 

Two teams of two people will be needed to check the traps twice daily when traps are opened in 

the morning. Traps will either be checked every few hours or be closed.  In the event of warm 

weather, over 90 degrees, the traps would be checked every two hours.  This method of checking 

traps will be used for the next three to four consecutive days, depending upon how many animals 

are captured. This will be determined in the field. 

 

4.1.2 Mammal Handling 

If an animal is found in a trap, the animal will be removed and placed into a 5 gallon bucket to be 

transported to the processing station. A China Marker (aka grease pencil) will be used to mark 

the location of the trap on the lid of the 5 gallon bucket. The trap will then be cleaned out using 
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gloved fingers, re-baited, and re-set. The handling and processing station should be centralized 

between the sites being trapped, if possible.  This will increase efficiency in the handling of the 

animals and decrease drive time, eliminating additional stress on the animals.  

 

4.1.3 Mammal Processing 

Trapped animals will be placed into “shrew boxes” with food and water until they can be 

processed. Food should be removed one hour prior to anesthetizing the animal. Live animals 

should be anesthetized with Carbon Dioxide (CO2). The animals will be euthanized via 

exsanguination and CO2, if necessary.  Animal handling and care will comply with guidelines of 

the American Society of Mammalogists (Sikes 2007) or site specific methods developed as part 

of the study.  

 

All animals will be deeply anesthetized to Plane 3 of anesthesia (animal has reduced respiration 

and surgery can be performed) to exsanguination after blood samples are collected. Animals will 

be anesthetized using CO2 gas in a chamber. Chamber Method: This method employs a top 

opening chamber that is charged with CO2 after introducing the animals. To operate the unit, turn 

only the valve on the tank (not the regulator valve). After the animals are placed in the chamber, 

a slow flow of CO2 should be continued for a few minutes to maintain a high concentration at the 

bottom of the chamber. (Casteel, email) 

 

Blood samples will be obtained from anesthetized animals by axial cut with surgical scissors and 

collected using heparinized capillary tubes or other appropriate sample containers. One hundred 

microliters (μL) of blood is necessary for the ALAD analyses. The samples will be placed in 

small plastic vials, frozen in liquid nitrogen and shipped in containers with dry ice. The amount 

of blood needed for field hematocrit is dependent upon the size of the collection tubes and the 

centrifuge used. No preservation is needed as this analysis is conducted in the field. For blood 

lead analyses, between 50 and 100 μL is needed (with the latter preferred). The sample will be in 

a small plastic heparinized vial and will be hand carried on ice. Holding times for samples are 
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different for ALAD and lead analyses and are laboratory dependent. Samples will all be properly 

labeled for easy identification by both the laboratories and the Trustees for sample analytical 

reporting. 

 

Tissue samples used for histopathological analysis should be fixed in 10% neutral buffered 

formalin (37% formaldehyde) and will be taken back with staff from UM-SVM to be analyzed. 

Samples will be properly identified with labels for ease in analyzing and reporting results.  

4.2  Sampling Order 

We plan to start sampling at the mining sites and finish with the reference sites. The Viburnum 

Trend sites will be done first, with the state parks being second, and finally the reference 

locations. We plan to sample two to three sites at a time with a week for trapping. Therefore, the 

total sampling time will likely be two to three weeks. 

4.3  Sample Quantity  

We plan to collect about 100 small mammals for the main study and 10 animals in preliminary 

trapping. Blood from those 10 animals will be used adjust the ALAD method for use with small 

samples of blood.  It is likely that the majority of animals will be Peromyscus species (mice) but 

ideally we are targeting shrews, since they are insectivorous and their primary diet consists of 

earthworms. 

 

4.4 Analyses Requested 

All small mammals will be analyzed for blood ALAD; oxidative stress; DNA damage assay; 

kidney, spleen and liver tissue histopathology; blood histopathology; organs metals analysis; 

hematocrit; blood lead; and femur lead concentrations. Non-depurated worms will be analyzed 

for whole body metals. 
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4.5  Chain-of-Custody 

All blood samples and other tissue samples will have a chain-of-custody (COC) from the 

laboratory that is conducting the analyses; this will be sent with the samples to the lab. 

 

5.0  Earthworm/Soil Collection 

Earthworm and soil samples will be collected across a range of soil Pb concentrations to estimate 

the potential exposure of small mammals to Pb. Small mammals feeding on earthworms will 

incidentally ingest internal and external soil associated with earthworms.  

5.1 Earthworm collection 

Earthworm tissue contains some Pb, but the majority of Pb in tissue is generally much less than 

the soil contained in their intestines. During the May sampling of small mammals, earthworms 

and associated soils will be collected from holes dug at the locations of the mammal sampling. 

The earthworms will be rinsed with distilled water and frozen prior to depuration of the ingested 

soil. Earthworm samples will be sent to USGS Columbia Environmental Research Center 

(CERC) to be analyzed for Pb, iron (Fe), copper (Cu), nickel (Ni), Zn, Cd and aluminum (Al). 

Aluminum is used as a marker/indicator of soil. The samples will be analyzed using inductively 

coupled plasma-mass spectrometry (ICP-MS). Lab duplicates will be analyzed at a rate of 10% 

of total samples collected. 

5.2 Soil Collection 

Prior to placing the small mammal trapping grids, the area will be checked for Pb concentrations 

by using an X-ray fluorescence (XRF). If the area has an average Pb concentration of greater 

than 1000 ppm, then the area is suitable for trap placement. 

Once the grids are placed, an incremental composite sampling (ICS) approach will be used to 

collect soil samples within the sampling units (SUs) (aka trapping grids). ICS is designed to 

obtain a single soil sample that contains contaminants in the same proportion in the sample as 
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they are present in the volume of soil of interest (i.e. representative samples). This is achieved 

through the collection of many increments of adequate-mass systematically across each SU from 

the same depth (0-2 inches). A total of 30 increments will be collected from each SU (each 

sampling grid) resulting in one composite sample. These samples will be analyzed in-house 

using Olympus brand XRFs.  Confirmatory samples (at a rate of 10% of total samples collected) 

will be sent to the USGS-CERC for analyses using the same method as the earthworms (ICP-

MS). Soil samples will be analyzed for Pb, Zn, Cd, Cu, Al, Fe and Ni.  

6.0  Quality Control 

6.1 Field Decontamination 

Clean disposable latex gloves will be worn over leather gloves by staff handling traps and/or the 

animals directly. Traps will be decontaminated after an animal has been trapped only if the trap 

is too dirty for re-use. All traps will be decontaminated when trapping is completed at that site. 

The traps will be cleaned with Simple Green Cleaner and rinsed with deionized (DI) water and 

allowed to air dry. 

6.2 Quality Assurance/Quality Control (QA/QC) Samples 

The following samples will be collected as part of the quality control/quality assurance 

procedures for the investigation: hematocrit; ALAD analysis; blood lead/blood tissue; 

blood/tissue histopathology; femur analysis; oxidative stress/DNA damage assay. 

6.2.1 Laboratory QC 

Laboratory precision and accuracy will be assessed as described in the Quality Assurance Project 

Plan (QAPP) for Natural Resource Damages, Revision 3, April, 2011. See Appendix F. 

 

7.0  Investigation Derived Wastes (IDW) Plan 

Efforts will be made to minimize IDW generation.  IDW may include animal carcasses, body 

fluids and disposable personal protective equipment (PPE). 
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Disposable PPE and disposable sampling equipment will generally be handled as solid waste, 

containerized, and properly disposed.  Wash and rinse waters generated during the processing of 

the animals  will generally be discharged to the ground on-site or, if warranted, containerized and 

returned to the UM-SVM for proper disposal. Animal carcasses will be handled at the UM-SVM 

as defined in their Standard Operating Procedures (SOPs). 

 

8.0 Site Safety 

A safety briefing will be held on-site prior to initiating field activities and field personnel will be 

required to read and sign the site-specific health and safety plan.  The site safety plan is attached 

as Appendix A. 

 

9.0 Reporting 

Samples results will be given in reports from the respective laboratories after samples have been 

analyzed and results have been quality checked.  

 

All ALAD activity values will be reported as nmol/ALAD used/min/mL RBC (red blood cells).  

Hematocrit will be reported as a percentage or fraction. Blood lead will be reported as μg/dL. All 

tissue lead values (including kidney, liver, spleen, and femur) will be reported as μg/g dry 

weight. Some samples may be reported as wet weight and converted to dry weight numbers. 
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MISSOURI DEPARTMENT OF NATURAL RESOURCES 

DIVISION OF ENVIRONMENTAL QUALITY 

HAZARDOUS WASTE PROGRAM 

 

SITE HEALTH AND SAFETY PLAN 

for the 

SOUTHEAST MISSOURI SMALL MAMMAL STUDY 

 

 

1.0 INTRODUCTION 

 

This plan has been prepared for implementation by DNR employees, using operating procedures for which they are 

specifically trained.  Any use of the plan by other agencies, organizations, or private individuals is at their own risk. 

 

2.0 KEY PERSONNEL 

STUDY CO-LEADER:     Kathy Rangen  

STUDY CO-LEADER:     Hillary Wakefield  

 

SAFETY OFFICER:       

 

OTHER PERSONNEL/TITLE: 

John Nichols, Environmental Specialist  

Ramona Huckstep, Environmental Specialist  

Eric Gramlich, Unit Chief  

Sean Counihan, Environmental Specialist  

  

John Weber, USFWS  

Dave Mosby, USFWS  
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3.0 SITE INFORMATION 

CONTAMINATED SITE NAMES:     a.) Washington State Park     b.) St. Joe State Park     c.) Viburnum Trend 

(includes 3 subsites on USFS properties)  

  

REFERENCE SITE NAMES:     d.) Council Bluff Lake (USFS)     e.) Mill Creek Recreation Area (USFS)  

 

COUNTIES:     Washington (a), St. Francois (b), Iron (c & d), and Phelps (e)  

 

SAMPLING DATES:     April 29th through but not limited to May 31, 2013  

 

Site Description:   

 

   Investigation of mining chat piles in the Viburnum area. .  

  

 

 

3.1 Overall Incident Risk/Hazard Analysis 

Chemical:  Serious  Moderate      XX Low  Unknown 

Physical:  Serious  Moderate    XX   Low  Unknown 

3.2 Contaminant(s) of Concern:  Lead (Pb), Cadmium (Cd), Copper (Cu), Nickel (Ni), Zinc (Zn), and 

Arsenic (As).  

3.2.1 Physical State:   Liquid    XX   Solid  Sludge  Gas/Vapor 

Chemical Characteristics:  (check all that apply) 

a.           carcinogen  b. biological  c. corrosive  d. combustible 

e.  explosive  f. flammable  g. volatile      XX    h. poison 

i.  radioactive  j. reactive k. other:   

3.2.2 Physical Hazards:  (check all that apply) 

a.  overhead  b. below grade  c. confined space* d. noise 

e.  splash   f. fire/burn  g. puncture  h. heat stress 

i.  cut      XX     j. slip/trip/fall     XX     k. cold stress  l. electrical 

m.  mechanical/heavy equipment XX n. other: animals, insects, plants, hunters.  
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* The need for confined space entry by ESP personnel shall be evaluated on a site-by-site basis.  A confined 

space entry permit must be signed by the appropriate Unit or Section Chief prior to ESP employees 

entering a confined space (29 CFR 1910.146).  Confined space entry shall be screened in at least Level B 

prior to downgrade.  Adequate resources must be available and specific planning and tasks 

determined before confined space entry is initiated. 

 

3.2.3 Biological Hazards:   

 

3.3 Task-Specific Risk Analysis (attach additional sheets as necessary) 

 
Task Description Chemical Hazards Physical Hazards 

 
Level of 

Protection 

 
Sample Collection h  J,k,n 

 
D 

 
 

   
 

 
 

   
 

 
 

   
 

 
 

   
 

 

 

4.0 MEDICAL SURVEILLANCE AND PERSONNEL TRAINING REQUIREMENTS 

All ESP field personnel participate in a medical monitoring program and are trained at least to the level of 

"Hazardous Substance Emergency Response-Technician" as required and specified in the department's written 

health and safety program located in Section 2 of the MDNR-Hazardous Substances Emergency Response Plan 

(HSERP).  The written policy satisfies requirements set out in 29 CFR 1910.120.  MDNR ESP's respiratory 

protection program meets the requirements of 29 CFR 1910.134.   

 

ESP personnel will ascertain as much information as possible regarding health and safety issues associated with the 

site prior to initial entry.  Information shall include chemical and physical hazards as listed above, types and 

amounts of materials involved, and citizens/areas threatened by the incident. 
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5.0 PERSONAL PROTECTIVE EQUIPMENT 

ESP shall utilize the Protection Level categories defined in 29 CFR 1910.120, Appendix B, and known as Levels A, 

B, C, and D.  Refer to Section 2 of the MDNR-HSERP for definitions of Protection Levels.  ESP personnel shall 

inspect APRs and SCBAs at least monthly and maintain a record of such to ensure equipment is functional. 

 

Levels of protection shall be reassessed and upgraded as conditions change and information is updated to comply 

with worker safety while performing site activities. 

 

Action Levels for evacuation of work zone pending reassessment of conditions: 

Level D: O2 < 19.5% or > 25%; explosive atmosphere > 10% LEL; organic vapors > background levels; other . 

Level C: O2 < 19.5% or > 25%; explosive atmosphere > 20% LEL; organic vapors (in breathing zone) > 5 m.u.; 

other . 

Level B: O2 Explosive atmosphere > 20% LEL; unknown organic vapors (in breathing zone) > 500 m.u.; other . 

Level A: ESP personnel shall evaluate the need for entry on a site-specific basis and may utilize its emergency 

response contractor for Level A situations which may arise. 

 

 

6.0 FREQUENCY AND TYPE OF AIR MONITORING/SAMPLING 

 
Instrument 

 
Contaminant of Concern Sample Location 

(Area/Source) 

Frequency Odor Threshold/ 

Description 

 
NA 
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7.0 SITE CONTROL MEASURES 

 

7.1  The "Buddy-System":  ESP personnel performing any work activities within the exclusion zone shall employ 

the "buddy-system" at all times, as required and defined in Section 2 of the MDNR-HSERP.  The "buddy-system" 

may not be required while an ESP staff member is observing or providing oversight of cleanup activities performed 

by a contractor or responsible party. 

 

7.2  Safe work Practices:  Refer to Section 2 of the MDNR-HSERP for written safety practices to be followed at all 

times by ESP personnel while on-site at an incident. 

 

7.3 Site Communications:  The use of two-way radios or establishment of hand signals for communications shall be 

determined prior to entering the work zone and followed by ESP personnel. 

 

7.4 Radiation Safety:  Due to the possibility of an unknown radiation hazard being present on a site,  ESP personnel 

shall be required to wear radiation indicator badges (TLD badges) while on-site. 

 

7.5 Work Zones:  ESP personnel shall ensure work zones are established and be aware of their locations. 

 

 

8.0 DECONTAMINATION PROCEDURE/SOLUTIONS: 

Personnel: Gloves and clothing will be placed in a garbage bag and returned to Jefferson City for proper  

  disposal.  

Equipment: Returned to Jefferson City for proper decontamination.  

  

Instruments: Returned to Jefferson City for proper decontamination or disposal.  

  

 

Decontamination fluids/materials may be containerized for proper disposal. 

 

9.0 EMERGENCY INFORMATION: 

In the event of an emergency, notify the MDNR Environmental Emergency Response Office  

at 573/634-2436.  The Duty Officer will make the appropriate notifications. 
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10.0 ADDITIONAL EMERGENCY INFORMATION/NUMBERS: 

Hospital: Salem Memorial Hospital,  35629 Highway 72, Salem, MO  (573) 729-6626  

Location/Specific directions from Site: See Map directions.  

  

  

Name/Location     Telephone Number 

Ambulance:              Iron County Ambulance (573) 244-5966               

Police/Sheriff: Viburnum Police Department                                                     (573) 244-5220                

Fire: Quad County Fire Department                                                       (573) 244-5440                

Poision Control:  

Cellular Telephones/Other:  

1) Central Accident Reporting Office- WORK RELATED INJURY   1-800-624-2354    

This number is to be called in the event of a NON LIFE THREATENING injury PROIR to seeking medical care.  

  

  

  

 

 

11.0 SIGNATURES 

ESP personnel shall certify they have read the plan and addressed any questions regarding worker health and safety 

by signing and dating below followed by printing their name and title. 

 

Signature    Printed Name/Title   Date  TLD Badge 
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APPENDIX B 

Field Sheets: 

Sampling Area Field Sheet 
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APPENDIX C 
Study Area Map 
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I. Summary and Explanation of the Test 

 

A. Intended Use 

 

This method has been developed for use in the Missouri State Public Health Laboratory 

(MSPHL), Missouri Department of Health and Senior Services.  It is intended for routine 

screening (i.e., fingerstick via capillary tubes, known as capillary analysis) and confirmation 

(using lead-free venous tubes, known as venous analysis) of samples received from 

childhood lead screening programs. 

 

B. Summary and Explanation 

 

Lead is determined in blood by electrothermal atomization atomic absorption spectrometry 

using a method based on that described by Miller, et al (1).  Measurement is based on the 

amount of light absorbed at 283.3 nm by ground state atoms of lead from a lead lamp. Blood 

samples, blood-based quality control materials and water standards are diluted 1:10 with a 

matrix modifier solution containing nitric acid, Triton X-100 and ammonium dihydrogen 

phosphate.  The lead content is determined using an atomic absorption spectrometer 

equipped with Zeeman background correction.  Lead contamination must be carefully 

avoided throughout all procedures. All materials used for collecting and processing samples 

should be checked for possible lead contamination.  All work must be performed under 

clean conditions and protected from dust. 

 

C. Interferences 

 

This method is free from interferences when using matrix modifiers. Matrix modifiers 

permit the removal of interferences during charring by retarding the analyte atomization.  

Use of ammonium dihydrogen phosphate (NH4H2PO4) matrix modifier controls volatility 

of both the analyte and the contaminants. 

 

II. Sample Requirements and Processing 

 

A. Sample Collection 

 

Instructions for collection are provided to clients through our website at 

http://health.mo.gov/lab/bloodleadanalysis.php   

  

B. Sample Transport and Storage 

 

1.   Federal regulations (42CFR Part 72) require that blood specimens be packaged 

according to guidelines requiring the use of tertiary containment and sufficient absorbent 

material in the event that the specimen leaks during transit. 

 

2.   Venous blood specimens preserved with EDTA or heparin are stable for       

determining lead levels in blood for up to ten (10) weeks if refrigerated at 4 C.        

Refrigerated temperatures are not necessary for mailing blood lead specimens. When       

Page 4 of 25

B
lo

od
 P

b 
D

et
er

m
in

at
io

n 
by

 G
ra

ph
ite

 F
ur

na
ce

 A
to

m
ic

 A
bs

or
pt

io
n 

S
pe

ct
ro

sc
op

y 
 -

 V
er

si
on

: 2
2.

1.
 In

de
x:

 C
he

m
is

tr
y 

U
ni

t 5
9.

 P
rin

te
d:

 0
5-

F
eb

-2
01

4 
13

:1
7

Blood Pb Determination by Graphite Furnace Atomic Absorption Spectroscopy  - Version: 22.1. Index: Chemistry Unit 59. Printed: 05-Feb-2014 13:17

Authorized on: 04-Feb-2014. Authorized by: Alan Schaffer. SOP Unique Reference: 630-37779558. No review required.

Author(s): Alan Schaffer

DRAFT

http://health.mo.gov/lab/bloodleadanalysis.php


significant delays are expected, as might occur over a holiday weekend, it is prudent to       

store the sample locally refrigerated at 4 C, and ship them the next business day. 

 

 

C. Processing (acceptability and rejection of specimens) 

 

In the case of a problematic sample, attach a post-it note to the Blood Lead Form stating the 

problem.  Log in sample last.   Flagged Blood Lead Forms requiring calls need the 

following information documented in red on the form: 

 

  a. Initials of person making the call, date and time.  

  b. First and last name of person contacted. 

  c. Information received. 

  d. QA Event description statement in “For Lab Use Only” box. 

 

The copy of a faxed information sheet with documentation and written authorization is kept 

with the results.  The following are possible reasons for unacceptable blood lead samples: 

 1.   Sample submitted in collection device other than MSPHL device. 

  

a.  Venous tubes not provided by MSPHL must be certified lead free by the 

manufacturer.  If the provider cannot provide manufacturer lead free certification, 

then the submitter is contacted and given the option of having the MSPHL 1) 

analyze the sample as a screen (i.e., a capillary sample), 2) return the sample 

unanalyzed, or 3) destroy the sample.  If the submitter chooses to have the sample 

analyzed, then the blood Pb form is marked to indicate the sample is analyzed and 

reported as a capillary. 

 

b.  A sample received in a capillary tube not provided by MSPHL is analyzed 

normally (as a screen), provided that everything else is acceptable.  Call the 

submitter the first time they use alternate tubes, in order to inform them that 

MSPHL collection devices are sent to them free-of-charge. 

 

 2.   Sample ID does not match ID on test request form. 
 

  a.   Under “For Lab Use Only” write “Specimen ID does not match”. 

 

  b.   If this situation occurs the contact person for that facility is called and the   

discrepancy is discussed.   A fax is sent to the submitter requesting proper 

written    documentation of the problem.  A return fax with the correct 

information must be received before the sample is tested and reported.   

 

  c.  The following form is faxed to the submitter: 
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Missouri Department of Health and Senior Services 
P.O. Box 570, Jefferson City, MO 65102-0570     Phone: 573-751-6400     FAX: 573-751-6010  
 

Richard C. Dunn 
Director 

 

Bob Holden 
Governor 

 

Patient Information and Verification Form 
 

The Missouri State Public Health Laboratory received a blood lead testing specimen for which 

the form or tube was incomplete or mislabeled. 

 

 Name on tube was: ____________________________ 

  

Name on form was: ___________________________ 

 

Please fill out the required information below and fax this form to the chemistry department at 

(573) 522-4032. 

 

Your Facility Information 
 

Facility Name: _____________________________________ 

 

Address: __________________________________________ 

 

Patient Information 
 

Name: ____________________________________________ 

 

Date of Birth: ______________________________________ 

 

Sample Collection Date: ______________________________ 

 

Reason the form and tube did not match: (Example; used mother’s last name)  

 

_____________________________________________________________________________ 

 

Verification Statement 
 

I am able to identify this specimen positively as originating from the patient named above.  I 

accept responsibility for the sample identification and any resulting liabilities. 

 

Signed _____________________________   Date ________________ 

 

Print Your Name ______________________  
 

 

 

Upon receipt of proper documentation, attach it to the Blood Lead Form.  Correct the name on the 

Blood Lead form, if needed.  Initial and date any changes.  
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Recognizing that submitting facilities have individual turnover and personnel problems, the 

enforcement of this policy will be on an individual basis to be handled by the QA coordinator, 

laboratory supervisor or their designee.  

 

 

 

 3.   No return name/address on the information sheet. 

a. The information is taken from the mailer, if provided, or call the attending 

physician if no information is provided.  In “For Lab Use Only” box write 

appropriate QA event description statement. 

 

 4.   Sample(s) submitted that have clots or no identifying information on sample are       

                  unsatisfactory and will not be analyzed.  

a.   In the  “For Lab Use Only” box mark “Unable to analyze” and the appropriate 

box, “Insufficient Quantity”, “Specimen clotted , “Specimen Leaked in Transit”, “No 

identifying information on specimen”, or “Incorrect Collection Device”. 

 

 5.   When a facility has been contacted about samples with identifier problems, samples are 

held for two weeks.  If a completed patient information and verification form is not 

received, the specimen will be rejected for testing and the facility/requesting entity will be 

notified.  

 

D. Sample Log-in 

 

1. All blood samples are to be confined to a designated area. This includes but not limited 

 to: 

 

a.   Sample log-in bench and biological safety cabinet (BSC) 

b.   Refrigerator for storage  

c.   Racks for samples 

d.   Eppendorf pipettes and other equipment that could be contaminated with blood 

must be sanitized before using in another area. 

 

2. Blood sample containers are opened in BSC only.  Before opening or transporting any 

sample put on (this is the minimum protection required):  

 

  a.   Protective gloves  

  b.   Safety glasses 

c.   Liquid repellant lab coat 

 

 3.  Open mailers, remove samples and information sheets.  

 

  a.   Match sample with information sheet.  

 

b.   If the form is not marked for capillary or venous, do so with red ink and include 

QC   
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      Event description statement in “For Lab Use Only” box. 

 

  c.   If there is blood on the information sheet: 

 i.   If one or two of the three copies, remove those copies. 

ii.  If all the copies, transcribe the information to a new sheet.  Put all 

contaminated sheets in biohazard bag.   

iii. Include appropriate QC Event description statement in the “For Lab Use 

Only” box. 

 

 d.  Put centrifuge tubes and cotton into a biohazard bag and the inner plastic screw 

top shipping tubes in a clear unmarked bag. 

 

e.   Check for problematic samples and follow the Processing guidelines 

(acceptability and rejection of specimens) on page 4.  All information sheets are 

checked for the CLIA Standard 493.1241 required information.  After opening the 

mailer, check the form to see if the facility name and address are on the form. If it is 

not present the mailer may be used to get that information. If form does not have the 

required information, log in the sample last and try to acquire the required 

information.  Place the sample in refrigerator and put unknown with the sample 

number on the board as a reminder that there is an unknown that is in the process of 

determining the unknown information. If the information cannot be acquired the 

sample will be reported as “Unable to Analyze” due to whatever is missing. The 

following required information must be checked before giving a laboratory log 

number: 

1. Name and address of the entity submitting the specimen. 

2. The patient’s name. 

3. The sex and date of birth of patient. 

4. Specimen collection date. 

5. Capillary or venous sample check box checked. 

 

                     f.   Venous samples are logged in first followed by capillary samples (i.e. given a  

       number). 

 

4.  Place number tape on sample tube and using the Rapidprint machine, stamp the Blood 

Lead Form in the space provided for the state lab serial number, date and time. 

    

5.  Write the lab sample number for the first sample in the next run, or any skipped 

samples, on the dry erase board. 

 

 6.   Wipe down all surfaces daily with germicidal wipes. 

 

6. Properly dispose of the biohazard bag in the biohazard receptacle for autoclaving and 

disposal by the Laboratory Sterilization room personnel. 

 

7. Mailers are taken to Central Services. Plastic shipping tubes are bagged and placed in 

the biohazard receptacle for autoclaving by the Laboratory Sterilization room personnel. 
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8. Mailers and plastic shipping tubes must be free of blood contamination. Contaminated 

mailers and plastic shipping tubes should be disposed of in the biohazard bag waste 

container. 

 

 9.   Information sheets are given to clerical for data entry. 

 

    10.  After data entry the information sheets are put into the blood lead logbook. 

 

E. Sample Retention and Disposal 

 

1. All QC must be in control and verified before any written or verbal result is released. 

 

2.   Samples can be disposed of after release of results.  See Sample and Waste Retention 

and Disposal SOP. 

a. Capillary samples are disposed in a biohazard bag. 

b. Venous samples are disposed in a sharps biohazard container. 

 

3.   Samples with identifier problems see II. C. 5. Processing (acceptability and rejection 

of specimens) on page 4. 

 

III. Material Requirements 

 

A. Equipment and Apparatus 

 

1. Perkin-Elmer Model 600 Atomic Absorption instrument.- Graphite furnace AA 

using transverse heated graphite atomizer with longitudinal Zeeman background 

correction and STPF conditions 

       2.   Vortex Mixer 

       3.   RapidPrint Date/Time/Log Number Stamper 

       4.   Rotamixer  

       5.   Eppendorf Digital Pipette 10-100 L with Eppendorf yellow tips 

       6.   Eppendorf Digital Pipette 100-1000 L with Eppendorf blue tips 

       7.   Eppendorf Digital Repeater plus Pipette with reusable 5 mL tips for matrix modifier 

       8.  THGA Graphite Tubes with Integral Platform (P.E.#BB3000-655) 

       9.   Blood collection tubes (lead free, heparinized or EDTA) 

     10.  Capillary Blood Collection devices 

     11.  Disposable autosampler cups, 2-mL 

     12.  Plexiglas 2-mL autosampler cup holder 

     13.  Laboratory tissues, e.g., Kimwipes
TM

 

     14.  Germicidal disposable wipes 

     15.  Sharps biohazard container for venous tubes and pipette tips 

     16.  Biohazard bags for non-sharps biohazard materials 

     17.  Clear unmarked bags for plastic shipping tubes 
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B. Reagents, Standards, and Controls 

 

1.   Lead stock solution, traceable to National Institute of Standards and Technology                                                                                                

standards, ~10 mg/g, or alternatively 10,000 mg/L.  Sources include NIST SRM 

3128 and SPEX Cat# PLPB2-3Y. 

       2.   Concentrated nitric acid (HNO3), trace metal grade (TMG) 

      3.   Deionized water  

       4.   Triton X-100, non-ionic detergent 

       5.   Ammonium dihydrogen phosphate, NH4H2PO4.  Use a grade that is lead free. 

       6.   Argon gas, ultra high pure grade 5, equipped with an approved gas regulator. 

7.   Blood-based quality control materials, including a low level (< 20 g/dL) and a high 

level (30-60 g/dL).  Sources include NIST SMR 955c, Kaulson Laboratory 

(Contox), and Bio- Rad. Freeze dried material is stored in Refrigerator 5310-2 at 2-8 

ºC. Reconstituted controls are stored in Freezer 5310-1 at or less than -20ºC.  See the 

Certificate of Analysis binder for the current standard CoA’s. 

      8.   Rinse Solution, comprised of TMG Nitric Acid, 10% Triton X and deionized water. 

 

IV. Preparatory Procedure 
 

Blood Lead Water Standards:  See QA Manual for labeling requirements. 
 

Standard Intermediate: 10.0 mg/L intermediate Pb stock in 1% HNO3 

 

 Add 1.0 mL stock to 1000 mL volumetric flask.  Add 10.0 mL of conc. HNO3 and   

fill to mark with deionized water.  Stable for three months stored at room temperature in 

Room 5310. 
 

Working Standard Solutions: Prepare the 30 ug/dL and 60 ug/dL solutions monthly. Store 

at room temperature in bio-safety cabinet. New standards are compared to old standards 

before they are put into use.  The 30 ug/dL standard must fall within its QC limits and the 60 

ug/dL must be within 2.3 ug/dL of the original standard result.  Run the A and B tubes of 

both the 30 and 60 ug/dL solutions along with the currently used standards for comparison.  

If any tested venous samples are above 60 ug/dL then prepare the 100 ug/dL standard 

solution.   Recalibrate, including the 100 ug/L standard, when rerunning a sample that is 

greater than 60 ug/L.  Capillary samples are screening samples and are not rerun with the 

100 ug/dL standard. 
 

 1. 30 g/dL – Add 3.0 mL of 10.0 mg/L intermediate Pb standard, plus 1 mL of conc. 

HNO3, into100 mL volumetric, then fill to mark with deionized water. 
 

 2. 60 g/dL – Add 6.0 mL of 10.0 mg/L intermediate Pb standard, plus 1 mL of conc. 

HNO3, into 100 mL volumetric, then fill to mark with deionized water. 
 

 3. 100 g/dL
a
 – Add 10.0 mL of 10.0 mg/L intermediate Pb standard, plus 1 mL of conc. 

HNO3, into 100 mL volumetric, then fill to mark with deionized water. 

                      
a
 This standard is only prepared when a sample result requires a calibration range greater than 0 - 60 g/dL. 
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 Standards:  50 L of the working standard solution is added to 450 L of Triton-X matrix 

modifier working solution. 

 

A. Matrix Modifier: (0.2% v/v HNO3, 0.5% v/v Triton X-100, 0.2% w/v (17.4 mM) 

NH4H2PO4) 

 

 1.   Stock 10% (v/v) Triton X-100:  Add ~80 mL of DI to a 100 mL flask.  Warm DI 

slightly.  Add 10 mL of Triton X-100. Swirl to mix and add DI to mark.  Mix thoroughly on 

a magnetic stirrer for at least one hour.  Prepare monthly.  Store at room temperature in 

Room 5310. 

 

 2.   Stock 20% (w/v) NH4H2PO4:  Add ~75 mL of DI to a 100 mL flask.  Dissolve 20 g of  

            NH4H2PO4, and add DI to mark.  Prepare at least every six months. Store in Refrigerator  

            5310-2 at 2-8ºC. 

 

 3.   Working solution of matrix modifier:  Add ~300 mL of deionized water to a 500 mL 

flask.  Add 1 mL of HNO3 and swirl to mix.  Add 25 mL of 10% (v/v) Triton X-100, 5 mL 

of 20% (w/v) NH4H2PO4, fill to mark with DI, and mix thoroughly
b
.  Prepare every 14 days.  

Store at room temperature in Room 5310. 

 

B. Reagent: 

 

Rinse Solution: In 2000 mL volumetric flask add 20 mL of Trace Metal Nitric Acid, 100 

uL 10% Triton X, then fill to mark with deionized water.  Store at room temperature in 

Room 5310 with no expiration date. 

 

C.  Safety Precautions 

 

A plastic apron worn over the regular lab coat (a properly closed liquid repellent lab coat 

may be substituted), protective gloves, and safety glasses must be worn when handling 

human samples. Opened sample containers must be kept in the BSC.  Gloves and gowns 

must be removed before leaving the work area.  Dispose of used items, such as gloves and 

gowns, in the biohazard bag.  At the end of the run, the autosampler cups containing the 

analyzed samples and all other possibly contaminated disposable materials are put into the 

biohazard bag.  Pipette tips and other sharps are put into the biohazard sharps container.  

The bench tops, equipment, and pipettes are wiped down with germicidal disposable cloth.  

The biohazard bag and biohazard sharps container are then properly disposed of.  See the 

MSPHL Chemistry Unit Chemical Hygiene Plan for further information. 

 

 

 

 

 

                      
b Given a modifier concentration in diluted blood of 0.18% w/v, total mass of NH4H2PO4 deposited on platform 

using a 12 L injection volume is 21.6 g. 
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D. Instrument Batch Preparation: 

 

Sample Information File Sample Locations for P.E. Model 600 AA: 

 

LOCATION         SAMPLE ID    LOCATION  SAMPLE ID 

        38   blank   5-24, 26-48      samples 

         1         control low       25, 49            duplicates for QC 

         2         control high         39         30 g/dL water cal std 

         3          control near reporting level
e
        40         60 g/dL water cal std 

         4      control mid range 

      

E. Pipetting Procedure: 

 

 1.  Place sample cups onto the square Plexiglas sample cup holder.  Pipette 450 L of the 

matrix modifier into each cup with Repeater plus pipette, taking care to not contaminate the 

tip.   

            Replace the tip if it becomes contaminated. 

 

 2.  All blood specimens and controls should be swirled gently and at room temperature prior 

to preparation (using vortex mixer for capillaries and hematology mixer for venous 

specimens and controls). 

     

     3.    Pipette 50 L of the standards, controls, and samples into each cup.  Refer to the 

printed Sample Information file for the sample cup positions.  Use a new tip on the 

Eppendorf Digital pipette (100-1000 uL) to mix solution in each cup 
g
. 

 

V. Test and shutdown procedure: 

 

A.  Instrument Batch Requirements: 

  

1. Standards, controls, and samples must be prepared for each instrument batch at the same 

time. 

 

2. The calibration correlation coefficient must be 0.997 or greater. 

 

3. Analysis of a sample batch requires analysis of 6 checks after calibration (a low-level 

control, a high-level control, a mid-range check standard, a mid-range control, a 

reporting-level control, and a blank), 2 checks after every 10 samples (a mid-range 

check standard and blank) and at the end of the batch. 

 

                      
e A control at 2.0 µg/dL reporting level is analyzed to verify the lowest reporting value. 

 

g 12 L of this solution is pipetted on the platform by the AS-71 auto sampler. 
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4. Venous samples are analyzed in duplicate. Any venous sample that is marked as 

“Confirmatory “or “Follow Up” will be analyzed the day it is received.  If the venous 

sample is marked as routine, or if nothing is marked, it will be analyzed when >30 

samples have been received. 
 

5. Capillary samples with a reading of  ≥9.5 g/dL must be analyzed in duplicate if the 

sample volume permits, if not rerun the original cup.  See Duplication Guidelines. 

 

6. The duplicate for QC is selected by the following criteria: 

 

a. Choose the first sample for a duplicate, and every 21
st
 sample after, for a duplicate 

provided there is enough sample available for analysis. If there is insufficient 

sample volume, go to the next sample with enough volume. 

 

7. The sample dust cover must be used during analysis. 

 

B. Instrument Settings: 

 

Furnace parameters are located under Method file name BLDLEAD. 

 

C. Instrument Setup: 

       

1.    Turn on the argon and verify that the tank pressure is >100 psi and outlet pressure 

should be ~46 psi. 

 

2. Turn on computer and the PerkinElmer 600 AA. The logon information window will 

appear on the computer. Enter “chemistry” as the password.  Double-click on the 

WINLAB 32 AA icon. The System Status window will appear, and the instrument 

software will take approximately 2 minutes to load.  Click on the Lamps button after 

software has loaded. Turn on the Lamp2 (Pb) button. The lamp is warmed up for 45 

minutes before analysis begins.  Before analysis check the energy of the lamp to make  

sure it is within those recorded in the BLOODPB.xls QC book and record the lamp  

energy. 

 

2. To check the number of tube and contact firings, select Diagnostics under the Tools 

menu.  Click on the Furnace tab and then the Set Cycles button.  A Set Cycles box 

will appear. The number of graphite tube cycles and contact ring cycles will be 

displayed.  If the tube has over 600 firings the tube should be replaced.  If the 

contact rings have over 7000 firings the contact rings should be replaced when the 

tube is changed.  See 600 AA Instrument Maintenance. 

 

3. In the Automated Analysis Control page click on File>Open workspace>Daily run 

view.  Open the Blank Sample Information File.  File>Open>Sample Information 

File> Blank Form> Open>Sample Information File Tab.  Enter the Sample ID’s in 

the appropriate positions.  After entering all the ID’s, save the Sample Information 

File by selecting File>Save As >Correct year Sample Info File > and enter the new 
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file name as MMDDYY>Save.  Click on the “Results Data Set Name” Open Button 

and the select Results Data Set Page will appear. Enter the same file name as the 

Sample Information File. Print the Sample Information File by selecting 

File>Print>Active window>OK.  If you want to print the complete run list, which 

includes all the QC samples, look in the Automated Analysis box and click on the 

“Print list” button.  Close the Sample Information window. 

 

4. Pipette the blank, standards, controls and samples. See Pipetting Procedure. 

 

5. Examine the tip of the autosampler. If it is bent or discolored, cut with scalpel and 

realign the tip. Check the proper alignment of the autosampler tip by analyzing a 

sample. If the alignment is not correct click on the Furnace Button. The Furnace 

Control page will appear, click on the Align Tip Button. The Align Autosampler Tip 

Wizard page will appear. Select Task as needed to perform from list. Press Next. 

Follow the directions listed on the page. Click finish when alignment task has been 

completed. 

 

6. Check sample drying by analyzing a blood control and water standard.  This can be              

checked visually with the mirror. Do not move the mirror until autosampler arm has 

reached the ready position. The sample must dry evenly, without boiling or 

sputtering.  This is especially important when a new tube and/or contact rings have 

been installed. The temperatures and times are listed in the Method Editor: Blood 

Lead Method Page.   

 

8.  To shutdown the system, turn off the EDL lamp by clicking on the Lamps Button, 

then Lamp#2 ON/OFF Button, close the WINLAB 32 AA Software, turn off the power 

to the 600AA, turn off the Argon gas, and shut down the instrument computer. 

 

D. Instrument Analysis: 

 

PerkinElmer 600 AA 

 

1.  Load sample cups of Blanks, Standards, Controls and samples in the sample tray 

positions as indicated on the Sample Information File. 

 

2. In the Automated Analysis Control Page click on the “Analyze All” button to start the 

analysis.  The “Analyze All” button will calibrate first, then run sample cups as listed in 

the Sample Information File.  The “Calibrate” button will calibrate only.  The “Analyze 

Samples” button will analyze samples only.  If the instrument stops on its own, due to 

QC issues, when you restart click on “Analyze All” and a box will pop up letting you 

choose where to start again.  If you stop the instrument you need to go into the MethEd 

tab> QC>schedule QC> uncheck those QC you do not want to run again>close.  Click 

on the “Reset Sequence” button and then the “Set up” tab.  In the Sample Info File 

column select locations and then input the locations of the samples that are needed.  

Click on the “Analyze” tab and then “Rebuild list”.  Verify list is correct and then click 

on “Analyze Samples”. 
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3.  The sample analysis results are printed out as the samples are analyzed. Print the 

Instrument Report by selecting File>Utilities>Data Manager (C:\data- 

AA\Administrator\Results\results.mdb.>Select Result file>Report>Use existing 

design>Browse>bldPbreport.rep>preview>Print. 

 

 

E. Maintenance 
 

Refer to the PerkinElmer THGA Graphite Furnace User Guide: Chapter 3 System 

Maintenance.  
 

All maintenance to the instruments is recorded in the Excel QC folder: BloodPb/600 AA 

Maintenance Log. 

 

Graphite Tube Change and Conditioning 
 

 1.   Loosen the autosampler holding screw and swing the autosampler away from the 

furnace. 

 

2.   Select Diagnostics under the Tools menu.  Click on the Furnace tab and the number of 

graphite tube cycles will be displayed.  Set the tube cycles to zero (number of cycles are 

recorded in the maintenance file).  Click on the furnace button on the toolbar and open the 

furnace. 

 

3. See Perkin Elmer THGA Graphite Furnace User Guide Pg. 3-10 to 3-18, for 

instructions on how to change the tube. 

 

 4.   The contact rings are swabbed with alcohol before installing the new tube.  Wear 

protective gear when replacing tube.   

 

 5.   Once the tube is changed, close the furnace and press the Condition Tube button.  Make 

sure the temperature program has started.  Conditioning twice may provide better results. 

 

6.   Check the autosampler alignment and droplet delivery after the conditioning program 

has run.  See Perkin Elmer THGA Graphite Furnace User Guide, pg. 2-17 to 2-23. 
 

  

      Autosampler Tip Replacement 

 

 1. See “Repairing a pipet” in PerkinElmer THGA Graphite Furnace User Guide, Pg. 3-47 

to 3-51. 

  

Contact Ring Replacement 
 

1. See “Changing the graphite contacts” in PerkinElmer THGA Graphite Furnace User 

Guide, Chapter 3, Pg. 3-19 to 3-31, for instructions on how to change the contact rings. 
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Blood Lead Atomization Adjustment 

 

 1. As the atomization temperature is increased, the Pb absorbance of the blood controls   

(matrix) decreases at a faster rate than the water standards (matrix).  The point at which 

the absorbance values are equal is selected as the atomization temperature.  In general, at 

the temperature of 1200 the lead starts to volatilize, but the peaks are broad and 

inconsistent.  At 1300 there are consistent and well-shaped peaks, but the blood control 

absorbance is low compared to that of the water standards.  Setting the temperature at 

1250 produces consistent, well-shaped peaks in which the blood and water absorbance 

match. 

 

2. Setting the temperature at 1250 does not take into account variations among tubes 

during the lifetime of a tube.  To solve this problem, the temperature may need to be 

adjusted in order to avoid running consistently high or low.  The atomization temperature 

needs to be increased 50 degrees if the low and high controls at the beginning of the tray 

are running above the upper warning limit and the temperature may need to be decreased 

50 degrees if the controls are running below the lower warning limit.  The temperature 

should not be decreased to a point in which the water peaks do not come off within the 3-

second atomization time.  The temperature may have to be increased 50 degrees to keep 

peaks within the 3-second atomization time.  When a change is made in the atomization 

temperature, it is saved in the element file.  The date the change is made, the old 

temperature, and the new temperature is recorded in the BLOODPB.xls maintenance log 

for that instrument. 
 

EPPENDORF PIPETTES 

 

1.   After use, pipettes are sanitized with Sani-Cloths
®
.  Perform gravimetric testing of 

accuracy and precision for each Eppendorf and record in Pipette Maintenance and QC 

notebook yearly or as need indicates. 

 

VI. Quality Control 

 

 1.  Any unusual circumstance should be reported to supervisor as soon as possible. 

 

 2.  Reliable QC materials should be used for this analysis.  Avoid using 'spiked' blood 

material that may cause a variety of matrix effects.  Ensure that reputable laboratories using 

several methods establish the QC target value.  Sources for standards and QC materials 

should be independent of each other. 

 

3.  Freeze-dried materials must be reconstituted according to the manufacturer’s 

instructions.  It should be noted that reconstituted freeze-dried blood, even more so than 

fresh whole blood, is a suspension rather than a solution and must be well mixed to obtain 

reliable results.  If freeze-dried blood is mixed too vigorously, however, bubbles will result, 

leading to pipetting errors.  There are 3 levels of Bio-Rad or Kaulson Laboratories QC 

controls used in this method, Level 1 (low level), Level 2 (mid-level), and Level 3 (high-

level). The Minimum Reporting Level (MRL) control is made by diluting Level 1 to 
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produce the reporting limit value of 2.0 g/dL.  The amount of de-ionized water used in the 

dilution is totally dependent on the initial concentration value of the Level 1 QC control.  
 

4.  Reconstituted vials are mixed on the hematology mixer for at least 20 minutes. 

 

 

A. Controls 

 

1.   X-bar for each blood lead control chart shall be based on control’s mean value.  The 

upper and lower limits for control are + 3 standard deviations and must not exceed + 4 

g/dL for controls with a value of less than 40 g/dL or ± 10% with a value greater than 

40 ug/dL.  Charts are recalculated when a new lot of controls are put in service and at 

least 7 data points have been accumulated. 

 

 2.   X-bar and standard deviation must be monitored on each control for each instrument. 

 

3.   Precision and accuracy are checked on the instrument using lead in bovine NIST SRMs
j
.    

NIST SRMs need only be analyzed when a new Bio-Rad or Kaulson control is 

reconstituted.  Aliquots of the reconstituted Bio-Rad or Kaulson control and the 

comparable NIST Level are analyzed with the old Bio-Rad or Kaulson control and can 

be analyzed with samples or be analyzed on a separate tray.  Results are recorded in 

BLOODPB.xls QC Book Monthly NIST sheet. 

  a.   Minimal criteria for NIST controls:    

                        

   i.   Results < 40 g/dL must be within + 4.0 g/dL, or for results > 40 g/dL  

                   + 10%, of target values. 

 

 b. Storage of NIST controls:  
 

i.    Controls will be stored at or below -20 degrees C in a non-frost free 

freezer in room 5310 in the original box and aluminized bag. 

   

  c.   When handling refrigerated NIST controls: 
 

i.    Follow Certificate of Analysis Use and Cautions .  Thaw at room 

temperature and swirl gently on the hematology mixer.  Do not use if 

clotted or if less than 1/3 of original volume remains. 

   ii.   Following good laboratory practices: do not leave controls at room  

        temperature in excess of time needed to measure control. 

   iii. Monitor for deterioration.  

      

   d.   Log containing the following will be kept: 
 

                      
j
 NIST SRM - National Institute of Standards & Technology Office of Reference Material. Standard Reference Material consists of 

blood from lead dosed cows.  Target values determined by ICP IDMS (+ uncertainly at the 0.95 confidence level). 
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i.   Date run, analyst, date opened, NIST values obtained, Bio-Rad or 

Kaulson values obtained.  

 

B. Proficiency Testing 

 

Three times a year the laboratory receives a set of 5 CDC CLIA Regulatory proficiency 

samples from the Wisconsin  State Laboratory of Hygiene (WSLH), the reported results 

are faxed to the WSLH.  If the laboratory misses a PT on a CLIA regulated method 

(Blood Lead), a Corrective Action Report (CAR) will need to be initiated and the 

laboratory will need to run an unknown control for an unbiased test of the ability to 

identify and quantify.  The QM will need to prepare the unknown (an old PT) in these 

cases and it will need to be listed that one was run in the CAR that is being written for the 

missed PT.   

 

C. Duplicates 

 

Duplicates samples are run every 20 samples and must be recorded in two ranges: 

  

1. Values > 20 g/dL as  +/- 2.3 g/dL  duplicate difference. 

 

2. Values < 20 g/dL 

If the sample and duplicate sample results are <0.4 (the current MDL), the 

dup difference is zero (0 minus 0).  If one result is above the MDL and the 

other is below, report the difference as positive or negative for the results 

above the MDL (e.g. 1.0 – 0 = 1.0, or 0 – 1.0 = -1.0). 

 

Duplication Guidelines 
 

1.    Capillary, and venous samples run as a screening sample, have results  9.6 make a 

second cup and, if they duplicate, average the two results.  If there is not enough to make 

a second cup, rerun cup #1.  If it duplicates, average the two results.  If it does not match, 

report to the supervisor and he/she will determine to report the sample as: a numerical 

value, QNS, or unable to analyze. 

 

2. If venous sample cups #1 and #2 do not duplicate, rerun both cups.  If they duplicate, 

average the results.  If the rerun does not duplicate, make a third cup, run and average 

the cups that match.   If there is not enough to make cup #3, report to the supervisor 

and he/she will determine whether to report the sample as: QNS, or unable to 

analyze. 

 

3. If venous sample cups #1, #2, and #3 do not match, report to the supervisor and 

he/she will determine whether to report the sample as QNS or unable to analyze. 

 

4.    For the duplicate QC samples:  If the original sample and it’s duplicate do not 

duplicate within the allowed limits rerun the duplicate sample.  If it still does not 

duplicate within limits remake the duplicate or another sample near the beginning of that 
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set of 20 samples if there is insufficient blood volume in the tube.  Report to the 

supervisor if that duplication is out of limits for determination of the next course of 

action. 

 

NOTE:  Analyst is required to document all duplication reruns and outcomes. 
 

D. QC Manual And Monthly Maintenance Schedule 

 

 1.   QC and maintenance must be kept for each instrument. 

 

2.   The following information will be kept for controls and duplicates for each instrument:  

  a.   Date analyzed 

  b.   Source of control and standard 

  c.   True value, obtained value 

  d.   Duplicate difference 

  e.  Analyst  

  f.   Date new vial opened/date new standards made. 

E. Quality Control for Blood Lead Collection Devices 

 

For new lot numbers of collection devices to be used: 

 

 1.   The number of devices to be ordered from vendor is reserved with the same lot number. 

 

 2.   Partial shipment is made, and devices are analyzed for contamination. 

 

  a.   Randomly select twenty collection devices from newly ordered lot. 

  b.   Fill sample containers 1.25 mL of dilute nitric acid (2% v/v)  

  c.   Store twenty-four hours at room temperature. 

  d.   Analyze leachate for lead and calculate the total amount of lead extracted. 

  e.   Report any contamination to supervisor. 

  f.    Record run date, lot #, analyst, and results on capillary blank chart. 

   

4. If the new lot number meets the criteria, shipment is completed and the new lot 

number can be shipped to submitters. 

 

5. QC Criteria for collection device- NO result equal to or greater than 2g/dL and 90 

% of results less than or equal to 1 g/dL.  

 

 For lot numbers of collection devices and/or repacks currently being used: 

 

1. Collection devices being shipped to submitters must be checked for contamination            

when repacks are done in the mailroom.  

  a.   Randomly select ten collection devices from current stock. 

  b.   Follow 2.b. through 2.d. of “new lot numbers of collection devices to be used” 
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 c.   Report any contamination to supervisor.  If any measurable increase in lead 

concentration of repacks compared to same lot number results, cause must be 

found and corrected. 

d.   Record run date, lot #, repack date, analyst, and results on capillary blank 

chart. 

e.  QC Criteria for collection device- NO result equal to or greater than 2g/dL 

and 90% of results less than or equal to 1 g/dL.  

 

F. Preparation of Capillary Kits  

 

 1.  Contents of kit: 

  a.   10 or 50 Capillary collection devices 

  b.   10 or 50 Capillary labels  

  c.   10 or 50 forms Lab 13C (1-04) 

  d.   1 instruction sheet (use copy of the original). 

  e.   Mailers/return labels as requested. 

 

 2.  Preparation of kit 

  a. Before preparing kits clean work area with soap and water. 

 b. Cover work area with bench protectors (obtained from Chemistry Unit). 

  c. Prepare a minimum of 20 kits at a time. 

  d. All collection devices MUST be handled with POWDER-FREE gloves . 

  e.  DO NOT handle the collection devices by the capillary (the straw-like part) or 

 the cap.  

  f.  Label kit with: 

   i.  Expiration date (from original bag). 

   ii. Date kit was prepared. 

g.  After all kits for day are prepared take one bag selected at random to chemistry 

unit for QC checking. 

   

 

G. Corrective Action to take when Quality Control fails Laboratory Criteria 

 

See the Corrective Action section of the Quality Assurance Manual for the process taken 

when a quality control failure occurs. 

 

 

VII.     Sample Reporting and Results 
 

 1.   Before reporting: 

 

  a. Blood Lead Instrument Report must be printed and venous samples averaged. 

      File>utilities>Data Manager>Select result file> Report>Use existing design>   

                       Browse>BldPb Report.rep>Preview>Print 

  b. Required data is entered into the Blood Pb QC in Excel. 

  c. QC must be verified to be in control in NWA. 
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d. Instrument Reports/sample analysis results must have a data review (See QA 

Manual-Data Reduction, validation and Reporting) by a peer analyst. 

 

      2.   Print the Blood Lead Log sheet from Access.  Transcribe results from the Instrument 

report on to the Blood Lead Log Sheet. 

  

 3.   Results on the Blood Lead Log Sheet are transcribed onto the Blood Lead Lab form 

13C. 

 

 4.   The completed Instrument report with sample analysis results, log sheet and Blood Lead 

Lab forms are taken to a peer analyst where the transcription check is completed as follows: 

 

a. The Blood Pb instrument report is checked against the Blood Lead Log Sheet.  

Initial and date the Blood Pb instrument report and the Log Sheet. 

b. The Blood Lead Log Sheet is checked against the Blood Lead Lab Forms.  Initial 

and date all Blood Lead Lab Forms. 

 

 5.   All Blood Lead Lab Forms are date/time stamped. 

 

 6.   Blood Lead results are released for distribution. 

 

 7.   The Blood Lead Log Sheet and Blood Lead Lab Forms are taken to clerical for data 

entry. 

 

      8.   Clerical does data entry and generates a Blood Lead Log Sheet with the computer-

entered results.  This is transcription checked and initialed by clerical. 

 

 9.  The Blood Pb instrument report with the sample analysis results is filed. 

 

10. The Blood Lead Log Sheet with the computer-entered results is placed in the Blood 

Lead Log Sheet file folder. 

 

A. Reporting Results 

 

 1.   All QC must be in control and verified before any written or verbal result is released. 

 

2. The top copy of the Blood Lead Lab Form is sent to the submitter, one copy is sent to 

the Lead Poisoning Prevention Program, and one copy is filed at MSPHL. 

 

 3.   Results are expressed as micrograms () lead (Pb) /deciliter (dL) blood. 

 

a.   Capillary and venous are reported to the nearest whole number on form Lab 13C.  

The Reporting limit is <2 g/dL blood 

 

 4.   See I:\Chemistry\QC\Excel QC Books\BLOODPB for the Method Detection Limit. 
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B. Verbal Release of Results 

 

 1.   Replying to telephone requests for results: 

 

  a. Blood lead results are NEVER given to a person calling the lab. 

 

  b. Information is taken from the caller. 

 

  c. A return call is made if the original caller is authorized to receive the result. 

 

3. Calling of high results: 

 

  a. All QC must be in control and verified before a result is released. 

 

b. Any result of > 20 g/dL blood is called to the submitting facility.  An analyst or 

clerical may make the call.  

 
  c. Document on form the first and last name of person receiving results, the date and 

 time of the call, and initials of person placing call. 

 

d. If the submitter cannot be reached by the end of the day make a copy of the form 

and send the batch of samples to clerical so that they can be mailed out.  After the 

submitter has been called bring the copy to clerical to be filed. 

 

C. Interpretation of Results and Normal Values 

 

Information to interpret results is found on back of the blood lead sample form.  This 

information and the contact information for the Missouri Department of Health and Senior 

Service blood lead program can be found on our website at 

http://health.mo.gov/lab/bloodleadanalysis.php   

 

VIII.     Continuation of Operations 

  

 The blood lead plan for continuation of operations in the event the test is unable to be 

performed at this laboratory is in the MSPHL COOP plan.  
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APPENDIX:  

REFERENCE SHEET FOR BLOOD LEAD ANALYSIS SOLUTIONS 

 

      STANDARD INTERMEDIATE: 10.0 mg/L intermediate Pb stock in 1% HNO3  

Stable for three months stored at room temperature in Room 5310. 
 

 1.0 mL 10,000 mg/L stock to 1000 mL in a volumetric flask.   

 10.0 mL of conc. HNO3   

 Fill to mark with deionized water.  

 

WORKING STANDARD SOLUTIONS: 
Prepared in an Acid rinsed 100 mL volumetric. 

 

 1. 30 g/dL –   3.0 mL of 10.0 mg/L intermediate Pb standard 

    1 mL of conc. HNO3, into  

                              Fill to mark with deionized water. 

 2. 60 g/dL –  6.0 mL of 10.0 mg/L intermediate Pb standard 

   1 mL of conc. HNO3  

                               Fill to mark with deionized water. 

 3. 100 g/dL –10.0 mL of 10.0 mg/L intermediate Pb standard 

   1 mL of conc. HNO3,  

                               Fill to mark with deionized water.  

 

MATRIX MODIFIER: (0.2% v/v HNO3, 0.5% v/v Triton X-100, 0.2% w/v (17.4 mM) 

NH4H2PO4) 

 

 1.   Stock 10% (v/v) Triton X-100:   

   Add ~80 mL of slightly warm DI to a 100 mL flask.     

             10 mL of Triton X-100.  Swirl to mix.  

  Fill to mark with deionized water. 

   Mix thoroughly on a magnetic stirrer for at least one hour.   

  Prepare monthly.  Store at room temperature in Room 5310. 

 

 2.   Stock 20% (w/v) NH4H2PO4:   

   Add ~75 mL of DI to a 100 mL flask.  

       Add 20 g of NH4H2PO4, dissolve before proceeding.   

  Fill to mark with deionized water.   
  Prepare at least every six months. Store in Refrigerator 5310-2 at 2-8ºC. 

 

 3.   Working solution of matrix modifier:   

  Add ~300 mL of deionized water to a 500 mL flask.   

             Add 1 mL of HNO3 and swirl to mix.   

  Add 25 mL of 10% (v/v) Triton X-100. 

  Add 5 mL of 20% (w/v) NH4H2PO4. 

  Fill to mark with deionized water and mix thoroughly.   

  Prepare every 14 days.  Store at room temperature in Room 5310. 
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REAGENT - Rinse Solution: 

  In 2000 mL volumetric flask  

 Add 20 mL of Trace Metal Nitric Acid to a 2000 mL flask. 

Add 100 uL 10% Triton X.   

Fill to mark with deionized water.   

 Store at room temperature in Room 5310 with no expiration date. 
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Scope 
 
This method provides procedures for determination of metal contamination in food 
samples. It is applicable to the following elements: 
 

Arsenic (As)   
Cadmium (Cd)  
Chromium (Cr)  

Lead (Pb)  
Mercury (Hg)  
Vanadium (V)  

 
 Summary of Method 

 
The method describes the multi-element determination of trace elements by ICPMS.  
Food samples will be homogenized, acid digested, and diluted. Then, sample material 
in solution is introduced by pneumatic nebulization into a radiofrequency plasma 
where energy transfer processes cause desolvation, atomization and ionization. The 
ions are extracted from the plasma through a differentially pumped vacuum interface 
and separated on the basis of their mass to-charge ratio by a quadrupole mass 
spectrometer having a minimum resolution capability of 1 amu peak width at 5% 
peak height. The ions transmitted through the quadrupole are detected by an electron 
multiplier or Faraday detector and the ion information processed by a data handling 
system. Interferences relating to the technique must be recognized and corrected for. 
Such corrections must include compensation for isobaric elemental interferences and 
interferences from polyatomic ions derived from the plasma gas, reagents or sample 
matrix.  Instrumental drift as well as suppressions or enhancements of instrument 
response caused by the sample matrix must be corrected for by the use of internal 
standards. 
 
 

 Interferences 
 
Isobaric elemental interferences - Are caused by isotopes of different elements 
which form singly or doubly charged ions of the same nominal mass-to-charge ratio 
and which cannot be resolved by the mass spectrometer in use.  All elements 
determined by this method have, at a minimum, one isotope free of isobaric elemental 
interference.  Of the analytical isotopes recommended for use with this method, only 
molybdenum-98 (ruthenium) and selenium-82 (krypton) have isobaric elemental 
interferences. If alternative analytical isotopes having higher natural abundance are 
selected in order to achieve greater sensitivity, an isobaric interference may occur. All 
data obtained under such conditions must be corrected by measuring the signal from 
another isotope of the interfering element and subtracting the appropriate signal ratio 
from the isotope of interest.  A record of this correction process should be included 
with the report of the data.  It should be noted that such corrections will only be as 
accurate as the accuracy of the isotope ratio used in the elemental equation for data 
calculations. Relevant isotope ratios should be established prior to the application of 
any corrections. 
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Abundance sensitivity - Is a property defining the degree to which the wings of a 
mass peak contribute to adjacent masses. The abundance sensitivity is affected by ion 
energy and quadrupole operating pressure.  Wing overlap interferences may result 
when a small ion peak is being measured adjacent to a large one. The potential for 
these interferences should be recognized and the spectrometer resolution adjusted to 
minimize them. 
 
Isobaric polyatomic ion interferences - Are caused by ions consisting of more than 
one atom which have the same nominal mass-to-charge ratio as the isotope of interest, 
and which cannot be resolved by the mass spectrometer in use. These ions are 
commonly formed in the plasma or interface system from support gases or sample 
components. Most of the common interferences have been identified. Such 
interferences must be recognized, and when they cannot be avoided by the selection 
of alternative analytical isotopes, appropriate corrections must be made to the data.    
Equations for the correction of data should be established at the time of the analytical 
run sequence as the polyatomic ion interferences will be highly dependent on the 
sample matrix and chosen instrument conditions. In particular, the common 82Kr 
interference that affects the determination of arsenic can be greatly reduced with the 
use of high purity krypton free argon. 
 
Physical interferences - Are associated with the physical processes which govern the 
transport of sample into the plasma, sample conversion processes in the plasma, and 
the transmission of ions through the plasma mass spectrometer interface. These 
interferences may result in differences between instrument responses for the sample 
and the calibration standards. Physical interferences may occur in the transfer of 
solution to the nebulizer (e.g., viscosity effects), at the point of aerosol formation and 
transport to the plasma (e.g., surface tension), or during excitation and ionization 
processes within the plasma itself. High levels of dissolved solids in the sample may 
contribute deposits of material on the extraction and/or skimmer cones reducing the 
effective diameter of the orifices and therefore ion transmission. Dissolved solids 
levels not exceeding 0.2% (w/v) have been recommended to reduce such effects.  
Internal standardization may be effectively used to compensate for many physical 
interference effects.   Internal standards ideally should have similar analytical 
behavior to the elements being determined. 
 
Memory interferences - Result when isotopes of elements in a previous sample 
contribute to the signals measured in a new sample. Memory effects can result from 
sample deposition on the sampler and skimmer cones and from the buildup of sample 
material in the plasma torch and spray chamber. The site where these effects occur is 
dependent on the element and can be minimized by flushing the system with a rinse 
blank between samples. The possibility of memory interferences should be 
recognized within an analytical run and suitable rinse times should be used to reduce 
them. The rinse times necessary for a particular element should be estimated prior to 
analysis. This may be achieved by aspirating a standard containing elements 
corresponding to 10 times the upper end of the linear range for a normal sample 
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analysis period, followed by analysis of the rinse blank at designated intervals. The 
length of time required to reduce analyte signals to within a factor of 10 of the 
method detection limit, should be noted. Memory interferences may also be assessed 
within an analytical run by using a minimum of three replicate integrations for data 
acquisition. If the integrated signal values drop consecutively, the analyst should be 
alerted to the possibility of a memory effect, and should examine the analyte 
concentration in the previous sample to identify if this was high. If a memory 
interference is suspected, the sample should be reanalyzed after a long rinse period. In 
the determination of mercury, which suffers from severe memory effects, the addition 
of 200 µg/L gold will effectively rinse 5 µg/L mercury in approximately two minutes. 
Higher concentrations will require a longer rinse time. 
 
 
 
 

 Safety 
 
The toxicity or carcinogenicity of reagents used in this method have not been fully 
established. Each chemical should be regarded as a potential health hazard and 
exposure to these compounds should be as low as reasonably achievable. The 
laboratory is responsible for maintaining a current awareness file of OSHA 
regulations regarding the safe handling of the chemicals specified in this method.   A 
reference file of material data handling sheets should also be available to all 
personnel involved in the chemical analysis. Specifically, concentrated nitric acid 
presents various hazards and is moderately toxic and extremely irritating to skin and 
mucus membranes. Use these reagents in a fume hood whenever possible and if eye 
or skin contact occurs, flush with large volumes of water. Always wear safety glasses 
or a shield for eye protection, protective clothing and observe proper mixing when 
working with these reagents.   
 
The acidification of samples containing reactive materials may result in the release of 
toxic gases, such as cyanides or sulfides. Acidification of samples should be done in a 
fume hood. 
 
All personnel handling environmental samples known to contain or to have been in 
contact with human waste should be immunized against known disease causative 
agents. 
 
Analytical plasma sources emit radiofrequency radiation in addition to intense UV 
radiation. Suitable precautions should be taken to protect personnel from such 
hazards. The inductively coupled plasma should only be viewed with proper eye 
protection from UV emissions. 
 
It is the responsibility of the user of this method to comply with relevant disposal 
and waste regulations. 
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Equipment and Supplies 
 
Inductively coupled plasma mass spectrometer: 
 

Instrument capable of scanning the mass range 5-250 amu with a minimum 
resolution capability of 1 amu peak width at 5% peak height.  Instrument may 
be fitted with a conventional or extended dynamic range detection system.  
Note: If an electron multiplier detector is being used, precautions should be 
taken, where necessary, to prevent exposure to high ion flux. Otherwise 
changes in instrument response or damage to the multiplier may result. 
 
Radio-frequency generator compliant with FCC regulations. 
 
Argon gas supply - High purity grade (99.99%). When analyses are conducted 
frequently, liquid argon is more economical and requires less frequent 
replacement of tanks than compressed argon in conventional cylinders. 
 
Ammonia gas supply – High purity grade (99.999%).  A lecture bottle is used 
to supply this reaction cell gas. 
 
A variable-speed peristaltic pump is required for solution delivery to the 
nebulizer. 
 
A mass-flow controller on the nebulizer gas supply is required. A water-
cooled spray chamber may be of benefit in reducing some types of 
interferences (e.g., from polyatomic oxide species). 
 
If an electron multiplier detector is being used, precautions should be taken, 
where necessary, to prevent exposure to high ion flux. Otherwise changes in 
instrument response or damage to the multiplier may result. Samples having 
high concentrations of elements beyond the linear range of the instrument and 
with isotopes falling within scanning windows should be diluted prior to 
analysis. 

 
MARS Express microwave accelerated reaction system. 

 
Mechanical pipettes. 
 
Centrifuge tubes (15 and 50 mL) and centrifuge tube racks. 

 
Volumetric flasks (polypropylene). 
 
Analytical balance. 
 
250 mL polypropylene reagent bottles. 
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Instrument Parameters 
 
 

Parameter Setting 
RF power 1.45 KW 
Ar nebulizer gas flow 0.90-1.05 LPM 
Detector mode Dual 
Measurement units Cps 
Replicates 3 
Readings/replicate 1 
Autolens On 
Blank subtraction After internal standard 
Curve type Linear through zero 
Sweeps/reading 8 
Dwell time 75 ms 
DRC Channel A 
DRC Gas Ammonia 
DRC – Flow (analysis) 0.5 mL/min 
DRC-RPq 
DRC-RPa 

0.25                        
0 

  
 

 Settings for Uptake and Rinse Times 
  
 Pump Speed Duration 
Sample flush -34 rpm 60 seconds 
Read delay and analysis -20 rpm 15 seconds 
Wash -24 rpm 45 seconds 
 

 
 

 
Terminology 

 
Calibration Blank - A volume of reagent water acidified with the same acid matrix 
as in the calibration standards. The calibration blank is a zero standard and is used to 
calibrate the ICP instrument. 
 
Calibration Standard - A solution of known concentration prepared from the 
dilution of stock standard solutions. The calibration solutions are used to calibrate the 
instrument response with respect to analyte concentration. 
 
Daily Performance Check (DPC) - This solution is used to determine acceptable 
instrument performance prior to calibration and sample analyses by checking the 
sensitivity, oxides, doubly-charged ions and background of the instrument.  
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Digestion Control – A food sample with known concentration of method analytes. 
The Digestion Control is obtained from a source external to the laboratory and 
different from the source of calibration standards. It is used to check either laboratory 
or instrument performance. 
 
Fortified Analytical Portion (FAP) – A portion of a food sample to which known 
quantities of the method analytes are added in the laboratory before digestion. The 
FAP is digested and analyzed exactly like a sample, and its purpose is to determine 
whether the sample matrix contributes bias to the analytical results.  The background 
concentrations of the analytes in the sample matrix must be determined in a separate 
aliquot and the measured values in the FAP corrected for background concentrations 
that have been normalized for the portion’s weight. One FAP will be run per food 
type (sample matrix). Matrix effects should be eliminated by the dilution of the 
digested sample. 
 
Fortified Analytical Solution (FAS) – An aliquot of sample after digestion and 
dilution to which known quantities of the method analytes are added in the laboratory. 
The FAS will be prepared as needed when the FAP is unsuccessful or when the FAP 
concentrations are inappropriate for the background concentration of any analytes. 
Fortification should be roughly twice the background concentration. 
 
Internal Standard - Pure analyte(s) added to a sample, extract, or standard solution 
in known amount(s) and used to measure the relative responses of other method 
analytes that are components of the same sample or solution. The internal standard 
must be an analyte that is not a sample component. 
 
Laboratory Fortified Blank (LFB) - An aliquot of DI water to which known 
quantities of the method analytes are added in the laboratory before digestion. The 
LFB is digested and analyzed exactly like a sample, and its purpose is to determine 
whether the methodology is in control and whether the laboratory is capable of 
making accurate and precise measurements. 

 
Method Detection Limit (MDL) - The minimum concentration of an analyte that 
can be identified, measured, and reported with 99% confidence that the analyte 
concentration is greater than zero. 
 
Quality Control Sample (QCS) - A solution of method analytes of known 
concentrations which is used to fortify an aliquot of calibration blank. The QCS is 
obtained from a source external to the laboratory and different from the source of 
calibration standards. It is used to check either laboratory or instrument performance. 
 
Stock Standard Solution - A concentrated solution containing one or more method 
analytes prepared in the laboratory using assayed reference materials or purchased 
from a reputable commercial source. 

 
 

Page 8 of 21

M
et

al
s 

in
 F

oo
d 

by
 IC

P
M

S
 -

 V
er

si
on

: 1
.0

. I
nd

ex
: C

he
m

is
tr

y 
U

ni
t 2

32
. P

rin
te

d:
 2

5-
M

ar
-2

01
4 

16
:0

8

Metals in Food by ICPMS - Version: 1.0. Index: Chemistry Unit 232. Printed: 25-Mar-2014 16:08

Authorized on: 19-Mar-2013. Authorized by: Alan Schaffer. SOP Unique Reference: view_only. No review required.

Author(s): Sondra Kekec

Unc
on

tro
lle

d 
Cop

y

DRAFT



 

 
 

 
 

Reagents, Standards, and Controls 
 
Nitric acid, concentrated, double distilled “Optima” and trace metal grade. 

 
Nitric acid 1+1 with 10 mg/L Au: 

Two liters of solution = 1000 mL of trace metal nitric acid + 1000 mL DI + 20 
mL of 1000 mg/L Au. This is the same solution used for metals in water analysis 
for sample preparation. The solution is kept in the east-end hood of room 5310. 

 
Internal Standard (IS): 

 In a 50 mL centrifuge tube add:  
• DI H2O (to total volume of 50 mL), 
• 2 mL of Nitric acid 1+1 with 10 mg/L Au, and  
• 500 µL of 10 mg/L Ir & Rh stock solution (Perkin Elmer Environmental 

Standard Mix 6). 
 
Internal Standard should be prepared every three months or as needed. 100 µL of 
internal standard will be added to each 10 mL digested sample or control aliquot.  

 
Standard Stock Solutions: 

Stock standards may be purchased from a reputable commercial source or 
prepared from ultra high-purity grade chemicals or metals (99.99-99.999% pure). 

 
Elements Source Concentration 

As, Cd, Cr, Pb, V Perkin Elmer kit 100 mg/L 
Hg Perkin Elmer kit 10 mg/L 

 
NOTE:  Fresh multi-element calibration standards and intermediates should be 
prepared every three months or as needed. 

 
 Standard Intermediates: 

Calibration Standard 
Intermediates 

Concentration Standard 
Source 

Preparation Instructions 

 
 

Multi-element (M.E.): 
As, Cd, Cr, Pb, V 

 
 

1 mg/L 

 
 

Perkin Elmer 
kit 100 mg/L 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 

with 10 mg/L Au, and 
• 1 mL of stock from 

standard source 
 

 
Hg 

 
 

0.1 mg/L 

 
 
Perkin Elmer 
kit 10 mg/L 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 

with 10 mg/L Au, and 
• 1 mL of stock from 

standard source. 
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Calibration Standards: 
 

Calibration 
Standard 

Elements and 
Concentration 

Preparation Instructions 

 
 

Calibration Blank 

 In a 100 mL volumetric add:  
• DI H2O,  
• 4 mL of Nitric acid 1+1 with 10 mg/L Au, 

and 
• Bring to volume, then add1 mL internal 

standard. 
 
 

 
Standard 1 

 
 
 

As, Cd, Cr, Hg, Pb, V 
 

0.1 µg/L 
 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 mg/L Au,  
• 100 µL Hg intermediate,  
• 10 µL M.E. intermediate, and 
• Bring to volume, then add1 mL internal 

standard. 
 

 
 

Standard 2 

 
 
 

As, Cd, Cr, Hg, Pb, V 
 

0.5 µg/L 
 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 mg/L Au,  
• 500 µL Hg intermediate,  
• 50 µL M.E. intermediate, and 
• Bring to volume, then add1 mL internal 

standard. 
 

 
 

Standard 3 

 
 
 

As, Cd, Cr, Hg, Pb, V 
 

1.0 µg/L 
 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 mg/L Au,  
• 1000 µL Hg intermediate,  
• 100 µL M.E. intermediate, and 
• Bring to volume, then add 1 mL internal 

standard. 
 

 
Standard 4 

 
 

As, Cd, Cr, Pb, V 
 

10 µg/L 
 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 mg/L Au,  
• 1 mL M.E. intermediate, and 
• Bring to volume, then add 1 mL internal 

standard. 
 

 
Standard 5 

 
 

As, Cd, Cr, Pb, V 
 

50 µg/L 
 

In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 mg/L Au,  
• 5 mL M.E. intermediate, and 
• Bring to volume, then add 1 mL internal 

standard. 
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Control Stock Solutions: 
 

Control standards may be purchased from a reputable commercial source or 
prepared from ultra high-purity grade chemicals or metals (99.99-99.999% pure). 

 
Elements Source Concentration 

As, Cd, Cr, Pb, V Spex multi-element 10 mg/L 
Hg Single element stocks 1000 mg/L 
 
NOTE:   Fresh multi-element control and intermediates should be prepared every 
three months or as needed. 

 
   Control Intermediates: 
 

Control 
Intermediate 

Concentration Standard 
Source 

Preparation Instructions 

 
 
 

Hg 

 
 
 

1 mg/L 

 
 
 

Single element  
1000 mg/L 

 
In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 10 

mg/L Au, and 
• 100 µL of stock from standard 

source. 
 

 
 

Control Elements and Concentration Preparation Instructions 
 
 
 
 

Control (QCS) 

 
 

 
As, Cd, Cr, Pb, V: 

5 µg/L 
 

Hg: 0.75 µg/L 
 

 
In a 100 mL volumetric add:  
• DI H2O, 
• 4 mL of Nitric acid 1+1 with 

10 mg/L Au,  
• 75 µL Hg intermediate,  
• 50 µL M.E. stock, and 
• 1 mL internal standard. 
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Daily Performance Check (DPC) Stock Solutions: 
 

Elements Source Concentration 
Be, U, In, Ce, Co, Pb, and Ba Spex single element stocks 1000 mg/L 
 

 
 

 Concentration Preparation Instructions 

 
DPC 

Intermediate 

 
1 mg/L 

Be, U, In, Ce, Co, Pb, and Ba 

In a 100 mL volumetric add:  
• DI H2O, 
• 0.5 mL of Optima Nitric acid, and 
• 100 µL of stock from each 

standard source. 
 

DPC Solution 
 

1 µg/L 
Be, U, In, Ce, Co, Pb, and Ba 

In a 200 mL volumetric add:  
• DI H2O, 
• 1 mL of Optima Nitric acid, and 
• 200 µL of DPC Intermediate 

solution. 
 

 
Rinse Solution 
 

Add 20 mL of trace metal HNO3 and 400 µL of 1000 mg/L Au stock solution to 
DI with a final volume of 1000 mL.  This solution expires in six months. 

 
Dual Detector Calibration Solution 
 

  In a 50 mL centrifuge tube, add:  
• DI H2O (to 50 mL total volume), 
• 1 mL Nitric acid 1+1 with 10 mg/L Au, 
• 100 µL Perkin Elmer multi-element standard stock (100 mg/L), 
• 100 µL Perkin Elmer Th, U standard stock (100 mg/L), and 
• 100 µL metals in water Li spiking intermediate (100 mg/L). 

 
  This solution expires in one year. 
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Quality Control 
 

Instrument performance - For all determinations the laboratory must check instrument 
performance and verify that the instrument is properly calibrated on a continuing 
basis. To verify calibration, run the calibration blank and calibration standard three as 
surrogate samples immediately following each calibration routine, after every ten 
samples, and at the end of the sample run. The results of the analyses of the standards 
will indicate whether the calibration remains valid. For the initial calibration and 
calibration blank verification, all analytes within the standard solutions must be 
within ±10% of calibration.  If the calibration cannot be verified within the specified 
limits, the instrument must be recalibrated.  For the continuing calibration and 
calibration blank verification, all analytes within the standard solutions must be 
within ±15% of calibration. If the continuing calibration check is not confirmed 
within ±15%, the previous 10 samples must be reanalyzed after recalibration.  

 
Quality control sample (QCS) – Verify the calibration standards and acceptable 
instrument performance with the preparation and analysis of a QCS. To verify the 
calibration standards, the determined mean concentration from three analyses of the 
QCS must be within ±10% of the stated QCS value. If the QCS is not within the 
required limits, an immediate second analysis of the QCS is recommended to confirm 
unacceptable performance. If the calibration standards and/or acceptable instrument 
performance cannot be verified, the source of the problem should be identified and 
corrected before continuing with on-going analyses. If necessary, the QCS may be 
rerun after sample analysis is complete. 
 
Laboratory fortified blank (LFB) - The laboratory must analyze at least one LFB with 
each batch of samples. The LFB will be fortified, then digested and analyzed like any 
sample. If the recovery of any analyte falls outside the required control limits of 85-
115%, that analyte is judged out of control, and the source of the problem should be 
identified and resolved before continuing analyses. If necessary, the LFB may be 
rerun after sample analysis is complete. 
 
Digestion Control – If available, a digestion control will be analyzed with each set of 
samples to be digested. This is a food matrix sample with known concentrations of 
method analytes that will be digested and analyzed to verify laboratory and 
instrument performance. The percent recovery must fall within statistically derived 
limits.  

 
Duplicates – Sample homogeneity and the chemical nature of the sample matrix can 
affect analyte recovery and the quality of the data. Taking separate aliquots from the 
sample for replicate analyses can in some cases assess the effect. A duplicate sample 
will be digested and analyzed for each sample. The relative percent difference will be 
calculated and must be less than or equal to 25% for any analyte whose concentration 
is above the reporting limit.  
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Fortified Analytical Portion (FAP) - Sample homogeneity and the chemical nature of 
the sample matrix can affect analyte recovery and the quality of the data. Taking 
separate aliquots from the sample for fortified analyses can in some cases assess the 
effect. The laboratory will add a known amount of analyte to at least one sample per 
sample matrix. In each case the FAP aliquot must be a duplicate of the aliquot used 
for sample digestion and analysis and for total recoverable determinations added prior 
to sample preparation. The FAP’s added analyte concentration will be the same as 
that used in the laboratory fortified blank.  Calculate the percent recovery for each 
analyte, corrected for background concentrations measured in the unfortified sample 
and normalized for the amount of sample digested, and compare these values to the 
designated FAP recovery range of 70-130%. If the FAP recovery is unsuccessful, 
proceed with preparation and analysis of a fortified analytical solution (FAS) for that 
sample.   
 
Fortified Analytical Solution (FAS) – When the FAP fails, an aliquot of already 
digested and diluted sample will be fortified with a known concentration of analyte 
from the standard source. The added concentration should equal around double the 
background concentration of the sample solution.  
 
Upper Calibration Limit Verification – Any time a sample is analyzed with a 
concentration above that of the highest calibration standard, a QC standard with a 
concentration above the highest sample concentration must be prepared and analyzed 
to verify the linear dynamic range is valid up to that concentration.  The determined 
concentrations for the QC standard must be within 10% of expected values.   
 
Internal standards responses - The analyst is expected to monitor the responses from 
the internal standards throughout the sample set being analyzed. Ratios of the internal 
standards responses against each other should also be monitored routinely. This 
information may be used to detect potential problems caused by mass dependent drift, 
errors incurred in adding the internal standards or increases in the concentrations of 
individual internal standards caused by background contributions from the sample. 
The absolute response of any one internal standard must not deviate more than 60-
125% of the original response in the calibration blank. If deviations greater than these 
are observed, flush the instrument with the rinse blank and monitor the responses in 
the calibration blank.  If the responses of the internal standards are now within the 
limit, take a fresh aliquot of the sample, dilute by a further factor of two, add the 
internal standards and reanalyze. If after flushing the response of the internal 
standards in the calibration blank are out of limits, terminate the analysis and 
determine the cause of the drift. Possible causes of drift may be a partially blocked 
sampling cone or a change in the tuning condition of the instrument. 

 
Method detection limits (MDL) should be established for all analytes, using reagent 
water (blank) fortified at a concentration of two to five times the estimated detection 
limit.  To determine MDL values, take seven replicate aliquots of the fortified reagent 
water and process through the entire analytical method. 
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 Element, Isotope monitored, and Correction factors 
 
Element Isotope Monitored Correction Factor In ternal 

Standard 
V 50.944  Rh 
Cr 52.9407  Rh 
As 74.9216  Rh 
Rh 102.905   
Cd 110.904 - 1.073 * Pd108  -(0.712*Pd106) Rh 
Ir 192.963   

Hg 201.971  Ir 
Pb 207.977 +1*Pb206 +1*Pb207 Ir 

 
 
Sample Preparation Procedure 

 
When solid food samples are received, they must be homogenized. Cut into 
manageable pieces and load into the food processor. Blend until homogenized and 
then store in the fridge in Ziploc bags. Liquids and powders will be measured as 
received. 
 
Each digestion will consist of a blank, LFB, Control (if available), samples in 
duplicate, and at least one FAP per matrix.  
 
Digestion vessels must be digestion cleaned directly before analysis. This can also be 
done the day before analysis and the vessels left closed in the turntable overnight. Put 
10 mL of trace metal grade nitric acid into each vessel and assemble the vessel (place 
stopper on top of the vessel, screw on the cap, and tighten with the provided tool until 
it clicks). You need only to digestion clean as many vessels as you will need for your 
current analysis. Place vessels in the turntable arranged symmetrically. Place 
turntable into the microwave. From the Home screen select “Load Method” → “User 
Directory”→ “Cleaning – Xpress Method” → “Start”. 
 
After the digestion cleaning method is complete, allow the vessels to cool and take 
them to the hood in the middle of 5310. Fill the vessel with DI, and pour out into the 
acid waste, then rinse the digestion vessels with DI. 
 
Tare the vessels, then weigh samples into them to 1 g ± 0.1 g. Record the weight in 
the Metals in Food log book. For the blank and LFB, pipet 1 mL DI water into each 
vessel.  
 
To each vessel, add: 

• 8 mL of Optima HNO3 from the repipettor in the hood in the middle of 5310 
• 80 µL of 1000 mg/L Au stock solution  
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 To each FAP and the LFB, add: 
 

Spike Solution Amount Added Final Concentration 
ME Standard Intermediate 
(As, Cd, Cr, Pb, V 1 mg/L) 

100 µL 0.5 µg/L 

Hg from Perkin Elmer 10 mg/L 10 uL 0.5 µg/L 
 
Place stopper on top of the vessel.  Screw on the cap and tighten with the provided 
tool until it clicks.   

 
Place each vessel into the turntable arranging the vessels symmetrically.  Place the 
turntable into the microwave system.  From the Home screen select “Load Method” 
� “User Directory”.  Select the Metals in Food method.  Press “Start” to begin the 
digestion. 

 
 Metals in Food Digestion Parameters: 

 
Stage Power Ramp °°°°C Hold 

 Max %    
1 1600W 100 25:00 200 15:00 

 
When the method is complete, the instrument will proceed to post-run cool down to 
prevent the possibility of operator burns or acid spills.  Permit the vessels to cool for 
approximately 30 minutes.  Carefully remove the vessels from the turntable, open 
them in the fume hood, and transfer with DI water into a tared 250 mL bottle. Rinse 
the digestion vessel thoroughly with DI into the 250 mL bottle, and dilute to a final 
weight of 200 g for the sample solution. Mix thoroughly. 
 
Clean Up: Wipe out the inside of the microwave and turntable with a damp towel.  
Send the vessels, stoppers, and caps to the kitchen to be washed.  They will be acid 
rinsed when they come back from the kitchen and left closed and ready to be 
digestion cleaned for the next run. 
 
Prior to sample analysis, pipet 10 mL of sample into a 15 mL centrifuge tube. Add 
100 µL of internal standard to each 10 mL aliquot. Mix well and analyze.   
 
If an FAS needs to be prepared, follow the formula below to determine how many uL 
of which standard to add to a 10 mL aliquot of the sample: 
 

added Standard uL
)/(ionConcentrat Standard

10*)/(Requiredion Concentrat Final =
Lmg

Lug
 

 
The uL added to the 10 mL aliquot should be less than 500 uL. If it is more, use a 
higher standard if possible or adjust final concentration accordingly.  
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Instrument and Software Setup for the ICP-MS Procedure 
 

1. Turn on the computer and re-circulator and log into the operating system.  Check 
the waste collection vessel to see if it needs to be emptied. 
 
2. If the mixing tee is connected, remove it with the internal standard tubing and 
attach the autosampler line directly to the nebulizer. Set up the peristaltic pump 
tubing for the sample rinse station and for the sample introduction system by 
positioning the tubing and closing the pump clamps. Check tubing for wear and 
flattening; replace if necessary.   
 
3. Start the ELAN® ICPMS software from Windows™. 
 
4. Perform daily maintenance checks as described in the ELAN® ICPMS Hardware 
Guide section 4-2 (i.e., Ar supply pressure and tank level, interface components 
cleanliness and positioning, interface pump oil condition, etc.).  Note the base 
vacuum pressure in the INSTRUMENT window of the software. Before igniting the 
plasma, the vacuum is typically between 8 x 10-7 and 1.8 x 10-6 torr. Record any 
maintenance procedures, along with the base vacuum pressure, in the Excel QC Book 
(Ernie Instrument and Performance Log). 

 
5. In the INSTRUMENT window of the software, press the “Start” button to ignite 
the ELAN® ICPMS plasma. 

 
6. Place the autosampler rinse line in DI water during warm-up. Turn on the 
ammonia tank.  

 
7. In the DEVICES window, go to the Autosampler tab → press the “Probe” 
button→ “Go to Rinse”.   

 
8. In the DATASET window → File → New → open a new dataset by entering 
Year\XX Month\XXXXXXx (i.e. 2012\06 June\062112a).  

 
9. In the METHOD window → File → Open → Metals in Food Conditioning DRC. 
Then, in the SAMPLE window → “Manual” tab → “Analyze Sample”. Warm up the 
instrument for 30 minutes with the plasma on while the DRC is being conditioned. 

 
10. Check standards and controls to see if they have expired.  Remake as needed. 

 
11. After the DRC conditioning is complete, open the SAMPLE window → File → 
Open → XXXXXXx Metals in Food by ICPMS.sam template. Edit the sample 
template by replacing “Sample” with the sample log number. If more rows are 
needed, copy and paste existing rows and then edit the Sample ID and Autosampler 
Location. For each sample, enter the metals for which you will be analyzing in the 
description. Spike samples have nothing in the description. All samples including 
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spikes should have the Sample Type listed as “Sample”. Save the sample file by 
replacing XXXXXXx with the date (MMDDYY) followed by a letter. 

 
12. To print a copy of the run list, highlight all the batch index rows and then click on 
build run list.  Select Printable View and then print the run list. 

 
13. After warm-up is complete, perform a daily optimization and performance check.  

 
o In the SMARTTUNE window → Open → MIW Daily Performance 
Check.swz. Verify that Default.dac and Default.tun are selected. For the dataset, 
select “Browse” and open the dataset you created.  
o Place the autosampler rinse line in the MIF rinse solution, uncap the Daily 
Performance Check Solution in autosampler position 1, and press “Optimize”.  
o The smarttune will automatically perform an autolens calibration and a daily 
performance check. If the daily performance check passes, it will stop. If it does 
not, it will perform a nebulizer gas flow optimization and then another daily 
performance check.  
o If the second daily performance check still doesn’t pass, open the MIW 
Troubleshooting.swz file in the SMARTTUNE window, and optimize again 
following the same steps as before.  

 
14. Record the lens voltage for Indium in Ernie Instrument and Performance Log. 
This can be found in the OPTIMIZE window → Autolens tab, after the autolens 
calibration is complete.  

 
15. Reopen the files in the ELAN software that are going to be used to analyze the 
samples. Press the “R” button on the toolbar on the left hand side of the screen and 
verify the following files are open: 

o Method: Metals in Food by ICPMS.mth  
o Dataset and Sample: Check the dates. 
o Report: Metals in Food.rop 
o Tuning: default.tun 
o Optimization: default.dac 

 
16. Put the solutions to be analyzed in the autosampler positions listed on the printed 
run list. In the SAMPLE window, highlight the rows and click Build Run List. If you 
are prompted to save Default.dac, do so by overwriting the existing file. Check the 
run list to make sure all the QC standards are running after the calibration and that the 
CCV and blank are running after every ten samples and after all samples are 
completed. Analyze. 
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Reprocessing  
 
While a sample set is being analyzed, results can be checked to see if they are in 
control by opening a second copy of the ELAN software.  The second copy is titled 
ELAN Edit/Reprocess Session. 
 
1. Open the current method, dataset, and the Metals in Food report option. 
 
2. From the menu, select Analysis then Clear Calibration and Blank to remove any 
previously stored calibrations.  In the Dataset Window, highlight the blank and 
standards needed for the calibration curve and then click on the reprocess button. 

 
3. View the standard five report in the Report View window. Go to the Calibration 
View window to check the graphs and the correlation coefficients by selecting the 
“Stats” button. Verify that the calibration curves have passed the correlation 
coefficient limit of 0.999. 

 
4. Reprocess each QC individually and verify all quality control being checked is 
within limits. If results are out of limits, rerun the QC sample. If it is still out of 
limits, repour if appropriate. If that is out of limits, remake if appropriate. If still out 
of limits, remake standards and recalibrate if necessary. Digestion control and Spikes 
will need to be entered into the MIF calculator to calculate percent recovery. QCS 
and ICV/CCV percent recoveries can be easily calculated at the bench to verify they 
are within limits. 

 
5. Reprocess each sample individually. Check sample concentration values to make 
sure they are below the highest standard concentrations (50 µg/L for As, Cd, Cr, V, 
Pb; 1.0 µg/L for Hg). If results are above the highest standard concentration, the 
upper calibration limit must be verified by running a QC standard of known 
concentration above the highest sample concentration. This sample must be within 
±10% of the expected value to verify that the linear dynamic range extends to that 
concentration.  For example, if an analyzed sample contains 75 µg/L Pb, a known 
standard solution containing 100 µg/L Pb should be prepared and run. (NOTE: If a 
dilution is necessary for a sample for which we cannot verify the linear range to its 
concentration, dilute with 4% HNO3, not blank, to a total of 10 mL and then add 
internal standard.) 

 
6. If QC samples were run with “Sample” as the Sample Type, the data file can be 
temporarily changed to the type of QC standard that was analyzed. Right click on the 
Sample Type before reprocessing and select the appropriate QC standard. This must 
be re-done every time you reprocess. 

 
7. After analysis has been completed and reprocessed, proceed with instrument 
shutdown.  Put the autosampler rinse line into DI water for 5 minutes.  Then take out 
the line to run dry.  When the sample line has dried, put the autosampler into standby 
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position (Go to Device window → Autosampler tab → “Probe” → “Go to standby” 
→ OK). 

 
8. Once the nebulizer has dried, go to the INSTRUMENT window → “Stop” to turn 
off the plasma, and wait to hear the instrument turn off (there will be a loud click). 

 
9. Turn off the ammonia tank.  

 
10. Close the program and shutdown the computer. Turn off the recirculator and 
release the clamps on the pump tubing. 

 
 

 
Reprocessing and Reporting 

 
1. To print the Metals in Food reports, in the METHOD window open the method 
used to run the samples. 

 
2. Select the report tab on the far right of the screen. Select “Send to Printer” under 
report view; “metals in food.rop” should be the template.  

 
3. Select “Send to File” under Report to File; “metals in food summary for qc 
transfer.rop” should be the template.  Enter today’s date under Report File Name.  
Make sure Use Delimiter and Use Separator under Report Format are selected.  
Append must be selected under File Write Option. 
 
4. In the DATASET window → Analysis → “Clear Calibration and Blank”.  Make 
sure the Read Type column has the right selection for QC samples.  Select the rows 
and click on Reprocess to print the reports. If a point is to be taken out, be sure to do 
standards first, then take a point out, and then reprocess the rest of the samples. 

 
5. To print out a Quantitative Analysis Calibration Report, in the REPORT VIEW 
window →  Open →  Quantitative Calibration.rop → right click anywhere on the 
screen → Print.  Add this to the report right after the calibration. 

 
6. To enter the data in the Excel QC book, open the Metals in Food Data Transfer 
Macro Excel book located in the I:\Chemistry\QC\Excel QC Books folder. Select 
Enable Macros. Click on Go!. Open the Report Output file. Close the small box. 
Click OK. Data will automatically be entered into the Metals in Food by ICPMS 
Excel QC book.  Remove data that is not needed or is out of control.  Only the 
beginning and end blank and CCV are needed.  Enter the date on each row that has 
data entered. Do not save the Metals in Food Data Transfer Macro Excel book when 
closing it. 

 
7. Open the MIF Calculator in I:\Chemistry\QC\Calculators\Metals in Food. Save as 
XXXXXXx. Enter the weight of each digested sample in the appropriate space from 
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the digestion logbook. (NOTE: If an FAS is run for a sample instead of an FAP, be 
certain that the weight for the spike is the same as the original sample.)   Enter the 
µg/L values for each sample from the printed reports. When completed, enter the 
digestion control and spike percent recoveries and the dup difference for any samples 
above the reporting limit in the Metals in Food Excel QC book. Print the calculator 
and place it with the report.  

 
8. The reporting limits are 0.02 µg/g for As, Cd, Hg, Pb, V, and Cr. 
 
 
 
 
 
References 
 

1. EPA method 200.8, Determination of Trace Elements in Waters and Wastes 
by Inductively Coupled Plasma - Mass Spectrometry, revision 5.4, EMMC 
version. 

2. Perkin Elmer application note, EPA Method 200.8 for the Analysis of 
Drinking and Wastewaters. 

3. Perkin Elmer Application note, Interference Removal and Analysis of 
Environmental Waters using the ELAN DRC-e ICP-MS. 

4. FDA document # T039, Determination of Trace Elements in Aqueous 
Solutions by Inductively Coupled Plasma – Mass Spectrometry (ICP-MS) 
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Glutathione Assay (DETECTX) 122112 Page 1 of  2 
 

Determination of GSH/GSSG using the Glutathione Fluorescent Detection Kit, Arbor Assays 

 

• Arbor Assays K006-F1. Stored at 4ºC. One kit is adequate for approximately 120 wells. 

• Reagents not supplied: SSA (Sigma, cat# S2130-100G); 10X PBS (Fisher, cat# BP399-1). 

• Costar half plate supplied. For extra plates use Corning* 96 Well Half Area Black Flat 
Bottom Polystyrene NBS* (Fisher, cat# 07201205) 

• Liver concentration: 8.3 ug/ul (2011 samples) to 12.5 ug/ul (2010 samples), in 100 ul 1X 
PBS. 

 

1) Bring all reagents to RT before use. Fast cool centrifuge to 4oC.  

2) Turn on microplate reader and use 390 ex/520 em. 

3) Thaw PCR tube containing 25 ug/ul of liver supernatant in 1X PBS. Dilute to appropriate 
predetermined concentration (ug/ul) in 1X PBS. 

4) Prepare: 

a. Sample Diluent (for diluting standards and samples): one part 5% SSA, four parts 
Assay Buffer. For 1.5 mls: 300 ul 5%SSA + 1.2 mls Assay Buffer  

b. Reaction Mixture (25 ul per well): This volume of reagent is adequate for 59 wells.  

 Half plate  
NADPH conc  150 ul 
Glutathione Reductase Conc  150 ul 
Assay Buffer  1.2 mls 

 

5) Transfer 100 ul of supernatant to a 0.5 ml tube. Add 100 ul of 5% SSA.  Incubate for 10 
minutes at 4oC, inverting 3 times during incubation. Centrifuge 10,000 x g for 10 minutes at 
4oC.   

6) Prepare standards from 250 uM Glutathione standard.  

NOTE: If a large number of samples are being processed, prepare the standards 
immediately before adding to the plate so as to use standards within 1 hour. 
 

Conc Sample Diluent Standard 
25 315 ul 35 ul Glutathione Standard 
12.5 150 ul 150 ul of 25 uM 
9.375 125 ul 75 ul of 25 uM 
6.25 150 ul 150 ul of 12.5uM 
3.125 150 ul 150 ul of 6.25 uM 
1.56 150 ul 150 ul of 3.125 uM 
0.781 150 ul 150 ul of 1.56 uM 

 
7) Add 150 ul of Assay Buffer to 0.5 ml tube.  Transfer 100 ul of the supernatant to the 150 ul of 

Assay buffer. 
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8) Add 50 ul of each blank, standard and sample to a black half plate in duplicate using the 
dispense mode of an automatic pipette.   

9) Add 25 ul of ThioStar reagent to each well with an automatic pipette.  Mix on plate mixer for 
5 seconds. 

10) Incubate at RT for 15 minutes. Set up microplate reader.  

11) Set gain on microplate reader using the highest standard, read for Free GSH.  

12) Add 25 ul of Reaction Mixture to each well. Mix on plate mixer for 5 seconds. 

13)  Incubate at RT for 15 minutes. 

14)  Set gain on plate reader using highest standard, read. This will determine total GSH. 

15)  Fluorometric calculations are based on blank corrected values, 4-Parameter logistic curve fit. 

16)  GSSG = (Total GSH-Free GSH)/2 
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Oxidative Stress Liver Preparation 
 
 

• Process 8-10 samples at a time.  This protocol will yield 4 aliquots for each sample.  
Three of the aliquots are 25 ug/ul, 100 ul in 1X PBS. 

 

1) Prepare labels and label 3 0.5 ml tubes with sample ID, 25 ug/ul in 100X PBS, date. 

2) Place vials containing the liver samples on ice.  

3) Tare a frozen weigh boat. 

4) Observe the frozen sample to estimate the total weight. If the amount approximates 100 
mg, weigh the entire sample. If the weight approximates greater than 100 mg, use a 
frozen spatula to slice and mix the sample while it’s nearly thawed. This ensures a 
representative sample. Weigh out 100-115 mg of tissue. 

5) Record the weight. Transfer the liver to a labeled homogenization tube on ice.  

6) Re-weigh the weigh boat and subtract any residual liquid from the weight. 

7) To ensure even homogenization, “cut” the liver tissue in the homogenization tube with 
the end of a spatula. 

8) Add a volume of 1X PBS for an equivalent concentration of 100 mg of tissue per ml of 
PBS. 

9) Cool the probe of the homogenizer by “homogenizing” the probe in ice cold DI water. 
Wipe probe and with the tube in a beaker of ice, homogenize the liver for 5 seconds, 
twice. Clean the homogenizer by rinsing thoroughly, wiping with a Kimwipe and then 
“homogenizing” ice cold DI water. Use forceps if needed to remove any tissue imbedded 
in the probe.  

10) Transfer homogenate to a 1.5 ml centrifuge tube. 

11) Centrifuge homogenate for 10 minutes at 10,000 x g in the pre-cooled, 4°C centrifuge. 

12) Transfer supernatant to 1.5 ml centrifuge tube labeled with the sample ID, date and “100 
mg/ml in 1X PBS”.  

13) Transfer 125 ul of supernatant to a 0.5 ml centrifuge tube. Add 375 ul of 1X PBS. 
Aliquot into 3 pre-labeled PCR tubes at 100 ul per tube.   

14) Store the 5 tubes, 3 at 100 ul/tube, 1 at > 100 ul/tube, and the 1.5 ml tube (100 ug/ul) in 
the -80 ºC. 
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Protocol for Determination of DNA Damage, 8- OHDG, in Liver 
 
 

DNA Purification: Gentra Puregene Tissue Kit (Qiagen, cat# 158622 or 158667) 

 

• Reagents not supplied: Proteinase K (Qiagen cat# 158918); RNase A (Qiagen, cat# 
158922); Isopropanol (Fisher cat# BP2618); Ethanol (Sigma-Aldrich, cat#r E7148) 

1) Place the rocker in the incubator and set to 55ºC. Set heat block to 37 ºC. Optional: prepare 
a set of tubes with 300 ul of isopropanol. 

2) Remove liver tissue from -80ºC and place on ice. Tissue sample can be placed in the -20ºC 
if they are at risk of thawing to quickly. 

3) Flame sterilize forceps and scalpel. Cool. 

4) Chill pre-labeled tubes and tare the first tube. With tissue still frozen, slice off a small piece 
of tissue and transfer to tube. Weigh out approximately 10 mg of tissue. 

5) Using a pestle, grind the tissue, keeping the tissue from the base of the tube where it would 
be compacted. 

6) Add 300 ul of cell lysis buffer and “wash” the pestle to remove any tissue stuck to it. Work 
quickly as DNA strands form a viscous solution. 

7) Add 2 ul Proteinase K to the sample cap. Cap, invert 25 times, incubate 3 hours on rocker, at 
55ºC. Cool to R.T. Place a piece of tape over the tubes to keep them in place and to facilitate 
turning them over every 60 minutes. 

8) Add 2 ul RNase A solution. Mix by inversion, 25 times and incubate at 37ºC for 15 minutes. 
Incubate 1 minute on ice (tissue protocol, not in blood protocol). Set heat block to 65ºC for 
rehydration step. 

9) Add 100 ul Protein Precipitate Solution, vortex vigorously, high setting, 20 seconds. 

10) Centrifuge 15,800 x g 20ºC, 3 minutes. If pellet is loose, vortex, place on ice 5 minutes and 
recentrifuge. 

11) Transfer the supernatant to a new 1.5 ml tube containing 300 ul of 100% isopropanol. 
Immediately invert gently 10-25 times, proceed to next sample. After all samples are in 
isopropanol, mix all by gentle inversion for a total of 50 times. 

12) Centrifuge 15,800 x g for 1 minute (set centrifuge to 2 minutes as it takes one minute for the 
centrifuge to reach speed). Use a 1000 ul and 100 ul pipette to discard isopropanol. 

13) Add 300 ul of 70% ethanol and invert several times (10 times). 

14) Place tube in centrifuge in the opposite direction from the previous centrifugation. This will 
force the pellet to the other side of the tube and provide more efficient washing. Centrifuge 
15,800 x g for 1 minute (set centrifuge to 2 minutes). Remove as much ethanol as possible 
using a pipette. 

15)  Air dry 12 minutes. 
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16) Add 150 ul DNA hydration solution.  

17) Incubate sample at 65ºC, 45 minutes. “Flick” the tube every 15 minutes. Leave at room 
temperature overnight to complete rehydration OR cool 10 minutes and place in 4ºC, for 
short term storage. 

18) Determine DNA concentration and purity spectrophotometrically. 

19) Normalize samples to 15 ug in 100 ul of DNA Hydration buffer. Lower concentrations can 
be used. 

 

Waste Disposal: Collect discarded isopropanol and ethanol in a plastic container for disposal; 
neither is listed as a hazardous waste in the Chemical Waste Management Manual. 

 

DNA Digestion for ELISA 

 

• For digestion, 15 ug of DNA in 100 ul of DNA hydration buffer is required. Protocol can 
be scaled. 

• Reagents not supplied: Nuclease P1(Sigma-Aldrich cat# N8630); 3M sodium acetate, pH 
5.2 (Fisher cat# FERR1181); 1 M Tris pH 7.5 (Fisher, cat# BP 1757); Alkaline 
Phosphatase (NEB, cat# M02905); 0.1M  Zinc Chloride (Sigma-Aldrich, cat# 39059). 

1) Prepare a working solution of Nuclease P1 (5 U/ml) by diluting an aliquot of 500 U/ml, 
1:100 in 40 mM NaOAc. This is done by adding 180 ul of 40 mM NaOAC to the 20 ul 
aliquot, transferring 100 ul of this 50 U/ml solution to 900 ul of 40 mM NaOAC. One tube is 
adequate for ~2 ml of 5 U/ml working solution or nearly 40 samples. Concentration of 
working solution is 5 U/ml. Keep on ice.  

2) Remove an aliquot of Alkaline Phosphatase, 10 U/ml from the -20ºC. Keep working aliquot 
on ice. 

3) Thaw normalized samples. 

4) Denature the DNA at 95-100oC. Cool completely on ice 5 minutes. Microfuge 5 seconds or 
tap, shake or flick any condensate down into tube. 

5) Add 50 ul 40 mM NaOAc pH 5.0-5.4, 0.4 mM ZnCl. 

6) Add 50 ul of 5 U/ml Nuclease P1. Invert tubes to mix. Microfuge 5 seconds or tap, shake or 
flick any condensate down into tube. 

7) Incubate at 37ºC for 30 minutes. 

8) Adjust pH to 7.5-8.0 by adding 20 ul 1M Tris-HCl pH 7.5 (1/10 volume). 

9) Add 15 ul of 10 U/ml alkaline phosphatase. Invert to mix. Microfuge 5 seconds or tap, shake 
or flick any condensate down into tube. 

10) Incubate at 37ºC for 30 minutes. 

11) Boil samples for 10 minutes at 95ºC to inactivate alkaline phosphatase. Place samples on ice. 
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12) Total volume is 235 ul. Aliquot samples, 2 ug per tube, 4 tubes. For instance, if 13 ug DNA 
is digested, 36.4 ul per tube will equal 2 ug per tube. The remaining volume is stored in 
original tube. Samples will be diluted in EIA buffer for ELISA.  

13) Store samples at -20ºC 

 

Waste Disposal:  

None of the solutions for this protocol is hazardous. 
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DNA/RNA Oxidative Damage EIA Kit Cayman Chemical (Cat# 589320) for 8-OHDG  

 

• Please note that the Cayman booklet for this kit defines B0 has maximum binding. To avoid 
confusion, we define “MX” as maximum binding in this protocol, and “B” as blank. 

• Optimal concentration of digested DNA is 10 ng/ul or 500 ng per well. 

• Reagents not supplied: Ultrapure water (e.g. Fisher, Cat# BP2819-1) 

 

1) Bring reagents to room temperature. Keep ELISA wells in foil pouch until ready for use. 

2) Define plate map. Include 6 standards, blank, NSB (non-specific binding), MX (maximum 
bound), reference sample(s) and the day’s samples. All are run in duplicate. Also reserve 
one well for TA (Total Activity). 

3) Dilute buffers. Diluted buffer are stable for 2 months at 4ºC 

a. EIA Buffer: 5 ml of 10X EIA buffer in 45 ml Ultrapure water. Approximately 5 
ml is required per assay. 

b. Wash Buffer: 0.5 ml of 400X in 200 ml of Ultrapure water. Approximately 200 
ml is required per plate. 

4) Reconstitute Tracer and Antibody: Tracer and Antibody are stable for 4 weeks at 4ºC 

a. Reconstitute AChE Tracer with 6 ml of EIA buffer. Approximately 5 ml is 
required per plate. 

b. Reconstitute EIA Monoclonal Antibody with 6 ml of EIA buffer. Approximately 
5 ml is required per plate. 

5) Prepare Standards: standard at a concentration of 30 ng/ml is stable for 6 weeks at 4ºC. All 
other diluted standards in EIA buffer, stored at 4ºC, are stable for 24 hours. 

a. Equilibrate a pipette tip in ethanol. 

b. Transfer 100 ul of 8OHdG 300 ng/ml stock into a tube and add 900 ul of 
UltraPure water for a concentration of 30 ng/ml. All subsequent dilutions are in 
EIA buffer. Equilibrate pipette tip in the standard before transferring. 

 
ul Standard ul EIA Buffer Final Concentration Volume (ul) for std curve 

100 ul of 30 ng/ml 900 3 ng/ml Not used, for serial dilution 

400 ul of 3 ng/ml 500 1.33 ng/ml 500 

400 ul of 1.33ng/ml 500 592.6 pg/ml 500 

400 ul of 592.6 pg/ml 500 263.4 pg/ml 500 

400 ul of 263.4 pg/ml 500 117.1 pg/ml 500 

400 ul of 117.1 pg/ml 500 52 pg/ml 500 

DRAFT



USGS Patuxent Wildlife Research Center 3-18-13 

8OHdG General Protocol   5 
 

6) Thaw digested DNA samples on ice. Dilute with EIA buffer to 10 ng/ul. If an aliquot 
contains 2 ug of digested DNA in 36.4 ul, add 164 ul of EIA buffer. Mix PCR strips 
thoroughly by inversion. Individual tubes can be vortexed.  

At 50 ul of sample per well, the concentration of the sample per well will be 500 ng. 
Samples may require further dilution. Samples can be concentrated by pooling 2 or more 
2 ug aliquots.  

7) Determine the amount of Tracer required. Add Tracer dye to a concentration of 1% v/v, (e.g. 
50 ul of dye per 5.0 ml of Tracer). 

8) Determine the amount of Monoclonal Antibody required. Add Monoclonal Antibody dye to 
a concentration of 1% v/v. 

9) Add 100 ul EIA buffer to non-specific binding wells. 

10) Add 50 ul EIA buffer to maximum binding wells. 

11) Add standards, 50 ul, in duplicate. 

12) Add 50 ul of sample to wells. 

13) To all wells except Blank and TA, add 50 ul of Tracer 

14)  To all wells except Blank, TA and NSB, add 50 ul of Monoclonal Antibody 

15) Cover plate with sealer and parafilm. Incubate 18 hours at 4⁰C on rocker in refrigerator.  

 

Plate configuration example: 

 1 2 3 4 

A B B Sample Sample 

B NSB/Negative Control NSB/Negative Control Sample Sample 

C MX/Positive Control MX/Positive Control Sample Sample 

D S5 S5 Sample Sample 

E S4 S4 Sample Sample 

F S3 S3 Reference 1 Reference 1 

G S2 S2 Reference 2 Reference 2 

H S1 S1 TA  

 

S1-S5 = Standards, S5 lowest (52 pg/ml) = 50 ul sample + 50 ul Tracer + 50 ul Antibody 

NSB/Negative Control = Non-specific binding = 100 ul EIA buffer + 50 ul Tracer 

MX/Positive Control = Maximum binding = 50 ul EIA buffer + 50 ul Tracer + 50 ul Antibody 

TA = Total Activity = Tracer added at development 
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Well EIA Buffer Standard/Sample Tracer Antibody 
Blank (Empty) -- -- -- -- 
TA -- -- 5 ul at DEVELOPMENT -- 
NSB 100 ul -- 50 ul -- 
MX 50 ul -- 50 ul 50 ul 
Std/Sample  50 ul 50 ul 50 ul 

 

 

DAY 2 of ELISA 

 

16) Bring a vial of Ellman’s to room temperature. Immediately before use/before wash step, 
reconstitute Ellman’s Reagent by adding 20 ml UltraPure water to one vial of 100 dtn or 50 
ml Ultrapure water to 250 dtn. Protect from light. 

17) Retrieve the plate from the refrigerator. Carefully remove the plate sealer. Number the rows 
and/or pinch the sides of the holder together as strips may free themselves from the holder 
during the wash step. Empty the wells and collect this in a waste bottle (contains trace 
sodium azide). Rinse the plate five times with Wash Buffer, approximately 300 ul per well 
with each rinse. Blot well after each wash.  

18) Add 200 ul Ellman’s reagent to each well with multichannel automatic, dispense mode. 

19) Add 5 ul Tracer to Total Activity (TA) well. 

20) Cover the plate with sealer and foil, place on rocker. 

21) Rock in the dark at RT for 90 min.  

22) Wipe plate with a clean tissue and carefully remove sealer. If there’s a loss of Ellman’s 
Reagent, wash the plate three times with Wash Buffer, add fresh Ellman’s reagent and re-
incubate. Do not spin. 

23) Read at 410 nm. Check the absorbance at the MX wells. Read the plate when the absorbance 
of the MX wells are in the range of 0.3-1.0 AU (blank subtracted) or >0.3 and <2.0 (no 
subtraction).  

24) Read the plate again at 120 minutes. Reread immediately. If the absorbance exceeds 2.0, 
wash the plate, add fresh Ellman’s and redevelop. 

  

Waste Disposal:  

• EIA Buffer contains 0.1% Sodium Azide as a preservative. Sodium azide is a hazardous 
waste, P105 in the Chemical Waste Management Manual. The concentration is below 
3%, nonetheless, Ellman’s reagent, samples, tracer and antibody are collected for 
hazardous waste disposal. 

• Ellman’s reagent is 5,5'-Dithio-bis-(2-nitrobenzoic acid) and is not listed in the Chemical 
Waste Management Manual. Since it is reconstituted in EIA buffer (0.1% Sodium 
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Azide), it is collected for hazardous waste disposal. The percent of reconstituted Ellman’s 
reagent (w/v) is unknown. 

• Standard stock 300ng/ml is in ethanol. Ethanol can be combined with the ethanol waste 
from the DNA purification. Ethanol is not listed in the Chemical Waste Management 
Manual. 

• Wash buffer can be safely disposed down the drain. 

 

Data Analysis and Calculations: 

“MX” (not B0) is defined as maximum bond, and “B” is defined as blank. 

1) Corrected MX (Maximum Binding)= average NSB (blank corrected) minus the average MX 
(blank corrected); MX – NSB. The value should be approximately “1” 

2) Sample and Std Bound/MX = Sample or Standard blank corrected absorbance – average 
NSB (blank corrected)/Corrected MX 

3) Use the values from step 2 to determine the 4-parameter curve fit. 

 

Acceptance Criteria: 

• %CV for the standard curve is based on blank-corrected raw data and must be ≤20. 

• %CV for samples is based on 4-parameter fit and must be ≤ 20. 

• %CV for reference samples must be ≤ 20 between plates. 

• Blank (raw data) between runs should be comparable. 

• NSB (Non-specific binding), blank corrected should be approximately 0. 

• MX (Maximum binding) blank corrected should be below 2.0. Subtraction of NSB from 
MX should be approximately 1. This is the Corrected MX. 

• TA (Total activity) raw data should be approximately 3.5. 

• R2 values must be above 0.99. 
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Oxidative Stress TBARS Assay  
 

• Bioassay Solutions, kit: DTBA-100.  Range of assay: 0.1 uM to 1.5 uM MDA. 

• Reagents not supplied: Trichloroacetic acid (TCA; Sigma, Cat# T9159-100G); 10X PBS 
(Fisher, cat# BP399-1) 

• Optimal tissue concentration: 25 ug/ul in 100 ul in 1X PBS. 
 

1) Thaw TBA reagent. Set heat block with 2 inserts for 2.0 ml tubes to 100 ºC. Fast cool 
centrifuge to 4 ºC. Turn on microplate reader.  

2) Design plate map.  Include 7 standards, blank, 2 different reference samples and the day’s 
samples. All are run in duplicate. 

3) Thaw liver aliquot 25 ug/ul in 1X PBS, 100 ul on ice. 

4) Thaw a 25 ul aliquot of 150 uM MDA standard on ice.  

5) If the BCA assay follows, transfer 15 ul of sample to a separate tube containing 60 ul 1X PBS.  
Add 170 ul of 10% TCA (1:3).  If no BCA assay follows, add 200 ul of 10% TCA to 100 ul of 
25 ug/ul aliquot. Immediately invert to mix.  After last sample, invert all samples.  Invert again 
at 5, 10 and 15 minutes.  Incubate for a total of 15 minutes on ice. 

6) Centrifuge 10K x g for 10 minutes at 4oC. 

7) During TCA incubation, prepare standards: 

Conc MDA H2O 
1.5 uM 20 ul 150 uM 1980 ul 
1.0  uM 600 ul 1.5 uM 300 ul 
0.75 uM 500 ul 1.5 uM 500 ul 
0.5 uM 500 ul 1.0 uM 500 ul 
0.375 uM 500 ul 0.75 uM 500 ul 
0.188 uM 500 ul 0.375 uM 500 ul 
0.094 uM 500 ul 0.1875 uM 500 ul 
0  200ul directly to tube 

 

8) Transfer 200 ul of standard or sample to a 2.0 ml boiling tube.  Add 200 ul TBA reagent, 
vortex, protect from light with foil.  Place weight on top. Boil for 1 hour at 100ºC.   

9) Cool samples to RT (~ 8 minutes, change slots in rack to cool). Vortex, microfuge.  

10)  Add 150 ul of sample and standards in duplicate to assay plate. Sample mixtures contain TCA, 
DMSO and are volatile. If possible, open tubes and add to the round bottom plate under a hood.  

11) Set gain on plate reader using highest standard, read samples at 544 ex/590 em. 

12)  Fluorometric calculations are based on blank corrected values, 4-Parameter logistic curve fit. 
CV% must be <15. Curve will be linear. 

13) Return to the hood to decant assay solution into a hazardous waste vessel. 
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Calculations: 

Results are in uM (nmol/ml) of product.   

uM product * 150 ul (volume per well) = umol per well/1000 = nmol/well.  

100 ul * 25 (25 ug/ul aliquot)/300 ul * (200 ul/400 ul) * 150 ul sample volume = 6.3x10-4 g 
of tissue per well 

nmol/g= nmol per well/ gram of tissue per well 

 

Waste Disposal: 

Collect waste in a plastic container. Waste solution from this assay contains approximately 
50% DMSO (Dimethylsulfonic acid), 3.5% TCA (Trichloroacetic acid), and 0.35% TBA (4,6, 
dihydroxy-2-mercaptopyrimidine). 
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Oxidative Stress: Thiol Assay 
 
 

• Measure-IT™ Thiol Assay Kit (Life Technologies, Cat# M30550. ) 

• Reagent not supplied: 10X PBS (Fisher, Cat# BP399-1) 

• Half plate not supplied. Corning 96 Well Half Area Black Flat Bottom Polystyrene NBS 
(Fisher, cat# 07201205) 

• Optimal tissue concentration: 83 ug/well (2011 samples) to 125 ug/well (2010 samples). 
 

1) Allow Component A and Component B to come to room temperature. All additions and 
dilutions are with an auto-pipette. 

2) Ideally the Thiol assay follows immediately after the Glutathione assay and uses the same 8.3 
ug/ul in 1X PBS aliquot.  If the sample is on ice more than 5 hours it will run low. If a fresh 
aliquot is used, keep it on ice for 3 hours.  Samples on ice for a short time will run high. 

3) Design plate map to include 7 standards, blank, 2 different reference samples and the day’s 
samples. All are run in duplicate. 

4) Prepare standards from 6.6 mM stock (5/7/12).  Dilute 1:6 with water for 1.1 mM. Further 
dilute in water 1:10 for 110 uM. 

Standard Curve: 

Conc (uM) Standard PBS 

55* 920 ul of 110 uM 920 ul of 2XPBS 
40 640 ul of 55 uM 240ul of 1XPBS 
27.5 300 ul of 55 uM 300ul of 1XPBS 
20 300 ul of 40 uM 300ul of 1XPBS 
13.75 300 ul of 27.5 uM 300ul of 1XPBS 
10 300 ul of 20 uM 300ul of 1XPBS 
6.88 300 ul of 13.75 uM 300ul of 1XPBS 

*55 uM is the highest standard.  Above 55 uM curve is non-linear. 

 

5) Prepare working solution of thiol quantitation reagent.  Protect from light and use within 1 
hour: 

100 ul/well, dilute 100X (Component A) with quantitation buffer (Component B) 

For a full plate: 100 ul (Component A) + 10 mls quantitation buffer (Component B) 

3) Add 10 ul of each standard and sample in duplicate. 

4) Add 100 ul of working solution to each well. Mix on plate mixer for 3 minutes. Measure 
fluorescence after 5 minutes total using a microplate reader (excitation/emission 494/517 nm). 

5) Set gain on plate reader using highest standard, read. 

6)  Fluorometric calculations are based on 4-parameter fit but linear regression fit is equivalent. 
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7) Immediately repeat any samples as necessary, standard curve/samples are stable for at least an 
hour. 

8) Fluorometric calculations are based on blank corrected values, 4-Parameter logistic curve fit. 
CV% must be <15. Curve will be linear. 

Calculations: 

Results are in uM of product 

 uM product * 0.11 (volume per well) = nmol/well 

 10 ul * 8.3 (ug/ul) = 83 ug per well or 8.3x 10-5 g per well 

 Umol/g = nmol per well/ g per well 

 

Waste Disposal: 

Collect waste in a plastic container. Waste solution from this assay contains approximately 1% 
1,2 propanediol (= 1,2 dihydroxypropane, propylene glycol). 
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Study Species of Concern 
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QAPP for Natural Resource Damages 
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ACUC Form 
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